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Dan Silva's interest in computers and computer graphics dates back to
the early sixties, when he was working towards his Master's degree in
Mechanical Engineering at Stanford University. At that time he was
using a computer to synthesize kinematic linkages, such as robot arms
and universal joints. Like most computer programmers during that
time, Dan was using the computer to avoid computational tedium,
with no inkling that it would one day become a tool for self-expression
and creativity.

He began to realize the computer's potential for creative self
expression during his four years with Informatics, a contractor to the
NASA Ames laboratory. During his spare time there, Dan wrote an
interactive language for displaying mathematical equations as
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his most interesting work after hours, when the computers would
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design for the Xerox Star system), that Dan realized he could make a
living having fun with computers. There followed a year at the newly
formed computer group at Lucasfilm designing a video editor, and then
back to Xerox, where he worked with Bill Bowman creating a next
generation bitmap editor. This effort produced Doodle, a Black and
White paint program running on the Xerox Dandelion computer.

By the time Dan joined Electronic Arts in 1983, he had a clear idea of
how the ideal paint program should behave. With this in mind, he
started work on Prism, a paint program that was to be an in-house tool
for software development. Needless to say, as Prism grew, so did its
marketplace potential, especially with the advent of new color
graphics-oriented computers. DeluxePaint was released in November,
1985 for the Commodore Amiga; and Dan started work on DeIuxePaint
II almost immediately. This version of DeIuxePaint II has been
adapted to take full advantage of the capabilities of Apple's
powerful new IIGS computer.
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1.1pgrade Certificate

fJ)eCu~Paint II

Do not send this Certificate until you are notified.

At the appropriate time, we will notify you about an upgrade to this
product, and invite you to send in this Certificate to receive your

upgrade. Because we can notify only registered owners, make sure you
send in the Registration Card included with your package.

No. 49602B

This Certificate is provided for the use of registered DeluxePaint II
owners only. No photocopies or facsimiles will be accepted.

Please allow four to six weeks for delivery

Gty State ZFP .
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As a registered owner of DeluxePaint II, you are entitled to receive future
upgrades of the product for a nominal cost. This Certificate is your proof
of ownership, and allows you to take advantage of future upgrades. Be

careful not to lose it. Upgrades could include enhancements or
refinements for increased power, efficiency and features.
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INTRODUCTION

Welcome to the world of computer-generated art. DeluxePaint is a
graphics tool that can help you create works of art with an ease and
precision that you may never have thought possible. After spending a
little time with this manual, you will be able to create colorful
graphics in a fraction of the time it would take you using more
traditional techniques. You will learn how to create perspective
effects, how to create and save your own custom brushes, how to mix
your own color palette from a universe of 4096 possible colors, and how
to create simple but effective on-screen animations, to name just a few
ofDeluxePaint's powerful features.

You don't have to read every word of this manual to become a
proficient DeluxePaint user. We have organized the information so
you can find what you need quickly and easily, and in a form best
suited to your style. For example, you can learn by working through
the tutorials in Chapter Three, or you can dive right in, and refer to
Chapter Four, the reference section, for answering any questions that
might arise. At the very least, however, you should read the section
entitled "About This Manual" at the end of this Introduction, so you
will know where to find the information you need. After that, you
should feel free to use the manual as you see fit. Remember, however,
that the more you read, the more you will get out of the program.
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INTRODUCTION

WHY COMPUTER GRAPHICS?

If you are new to computers or computer graphics, you may wonder
what advantages DeIuxePaint can provide over the more traditional
media. To begin with, DeIuxePaint does not pretend to be a substitute
for every kind of graphic medium. After all, there will always be a
place for fine oils on canvas, or for sculptures fashioned from Italian
marble. What DeIuxePaint can do, however, is help you create
prototypes of your designs quickly and easily, letting you move from
inspiration to execution in minutes instead of hours. Indeed, if
Leonardo Da Vinci were alive today, he would probably be using
DeIuxePaint to design his masterpieces and inventions. And if so, his
reasons would undoubtedly include the follOwing:

First, DeIuxePaint lets you do things that would be difficult, if not
impossible, using traditional methods. For example, you can pick up
any part of a picture and rotate it or flip it to create its mirror image.
You can shrink and expand an image on the screen until it is just the
right size, and then place it where it looks just right. Or you can
create a mathematically precise color range just by specifying the
beginning and ending shades and the number of steps in between.

Second, DeluxePaint is just like a word processor for graphic art. You
can move images from one part of the picture to another, or you can
copy an image and paste it in various places in your picture. You can
create a forest of leaves just by drawing a single leaf and pasting it
throughout your picture, or you can create clumps of leaves and paste
those throughout your picture. In addition, you can make global
changes to your artwork with ease. For example, if you decide that
the blue border around a picture should be red, or that the flesh tones
should contain a shade more tan, you can make the changes for the
entire picture at one time, without haVing to do it element by element.
Having created an element once, you don't need to create it a second
time if all you want to do is change one or more of its characteristics.
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Third, because you can save all your work on disk, you can build up a
library of images or clip art to use in future designs, without having to
create everything from scratch each time. And because you can save
versions of your picture as you go, you can always return to an earlier
state of a design and pick it up from there, if you like. Finally,
because you can print as many originals of a picture as you need, or
make unlimited copies of your data disks with no degradation from
one generation to the next, there need never be just one original of a
picture to lose or spill coffee on.

Because of DeluxePaint's ability to take you beyond traditional
media, you will find yourself developing a "new way of seeing," a new
approach to graphic art. Beginning landscape artists are sometimes
advised to view the scene upside down between their legs to eliminate
any extraneous factors brought about by past associations. In a similar
fashion (although you may not want to go so far as to stand on your
head), you can save yourself hours of tedium by finding new and more
efficient ways to create old effects. We will be exploring some of these
techniques in Chapter Three, but after a little experience you will be
able to come up with your own. DeluxePaint is the kind of software
that invites experimentation, so you should feel free to play around
with its various tools and effects. Remember, you can't hurt anything
by experimenting with the software, and you may even discover an
artistic side you never knew you had.
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INTRODUCTION

ABOUT THIS MANUAL

If you are new to computer graphics, we suggest you begin with
Chapter One, "A Guided Tour," where you will be introduced to
computer graphics and to DeluxePaint's fundamentals. There you will
learn how to start the program and how to save and load your pictures.
You will also learn about some of DeluxePaint's tools and techniques
through simple exercises. If you are a beginning computer graphics
artist, you will get the most out of the program by starting there.

If you already have some experience with graphics programs, you may
want to begin with Chapter Two, ''The Elements," which describes
each of DeluxePaint's elements and explains how they interrelate.
Each of the six elements (the Brushes, the Screen, the Palette, the
Tools, the Painting Modes, and Text) work together to give you the
power and versatility you need. There you will learn how to create
your own brushes, how to mix your own palette from a universe of 4096
colors, how to customize tools, and how to mix text and graphics.

No matter what your level of expertise, Chapter Three, "Tutorials,"
will help you understand some of DeluxePaint's more complex
features. These tutorials, designed with the assistance of professional
DeluxePaint artists, concentrate on the more advanced uses of the
program, such as the use of stencils, color mixing, perspective, and
color cycling to create simple animation effects. The short time you
invest working through these tutorials will payoff with interest
when you become a proficient DeluxePaint artist.

If you are already familiar with DeluxePaint, or if you prefer to jump
straight in without reading the documentation, Chapter Four,
"Reference" can answer any questions you may have. Chapter Four
documents everyone of DeluxePaint's features by menu item, keyboard
command, and tool icon. If you need a quick reference to any of
DeluxePaint's features, you can find it there.

1.4
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DeluxePaint has much to offer any user, whether amateur or
professional. If you are new to computer graphics and to DeluxePaint,
this section will introduce you to the new graphic medium through
simple step-by-step exercises. Here you'll learn how to create some
simple designs using the bul1t-in brushes and tools, and how to save a
picture onto a data disk.

o GETIING STARTED

SOFTWARE

Your DeluxePaint package contains two disks: 1) the program disk and
2) the bonus art disk. The program disk contains the instructions that
tell the computer to behave like a graphics workstation. The bonus art
disk contains data (a collection of sample images). These images are
stored in a collection of folders. As we shall see shortly, you access
these images by first selecting the folder, and then selecting the
image. You'll use some of the images on the art disk as you work
through the exercises in this manual.

HARDWARE

To use DeluxePaint you will need a IIGS, a monitor, one or two disk
drives, and some initialized blank disks for saving your work.
Finally, if you intend to print the files you create, you will need a
printer. Consult the Setting Up Your Apple IIGS manual for
information about connecting printers and other peripherals to the
IlGS.

ORGANIZING YOUR DISKS

We assume that you already know how to initialize disks (also called
formatting), copy disks, delete files, and move files from one disk to
another. If not, we suggest you consult your IlGS documentation before
going any further.
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POWER UP
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The first thing you should do is to make one or more working copies of
your DeluxePaint disk to reduce the chance of anything happening to
the original. You will also need to have one or more blank initialized
data disks handy for saving your pictures, brushes, and stencils.

When you are ready to go, just follow these instructions:

(~ Insert your working copy of DeluxePaint and tum on your computer
and monitor.

If you are using a two-drive system, put your working copy of the
program in drive 1 and the original in the drive 2; after the program
has loaded, you can eject the original and replace it with the
DeluxePaint art disk or your own initialized data disk.

If you are using a single drive, you will receive a message asking you to
insert the original disk. In that case, eject the copy and insert the
original program disk. This process (which is known as the keydisk
system because the original disk is the "key" that unlocks the system)
allows DeluxePaint to read a code from the original disk to make sure
that your copy is legitimate. When the drive stops spinning, eject the
original and put it back into storage. You won't be needing it again for
the rest of the session.

Starting DeluxePaint using a working copy saves wear and tear on your
original program disk. However, if you prefer, you can start with the
original disk in the drive, and replace it with the copy when the
program has loaded.

When the program has finished loading, you'll see the DeluxePaint
Painting Screen, with the painting area on the left, the Menu Bar on
the top, and the Toolbox and Palette on the right. Figure 1.1 below
also shows the optional Info Bar at the bottom of the screen. These
screen components are described in the rest of this chapter and in
Chapter 2.

Note: If you are using a Desktop with DeluxePaint, load DeluxePaint
as you would any other nes application.
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Figure 1.1. The Painting Screen

The Palette, the selection of 16 shades (two columns of eight shades
each) at the bottom right-hand comer of the screen contains a
representation of the color spectrum. (Sometimes we'll refer to this
Palette as the main Palette.) Note that the painting area to the left
of the Palette is white. This is the default background or page color,
so called because it is the color of the imaginary "page" you are
painting on. If you were to paint with the background color directly
onto the background, it would appear to have no effect, as if you were
putting white paint onto a white canvas. As we shall see in a moment,
painting with the background color is a way of erasing an image on the
page.

If this is your first time using DeluxePaint, we recommend you work
through the following section, where you will learn how to use many
of DeluxePaint's tools and techniques.

II GETTING ACQUAINTED

THE PALETIE
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Directly above the Palette is the Color Indicator, a rectangle of one
color inside a rectangle of another color. The inner rectangle shows the
foreground or brush color - the palette color that your brush is
currently loaded with. You can change this color at any time by
clicking one of the other colors in the Palette with the mouse button.
Try it. Move the pointer to one of the colors in the Palette and click.
Note that the inner rectangle in the Color Indicator changes to show
the new brush color. Click the other colors and see how the rectangle
changes each time.

The outer rectangle in the Color Indicator shows the current
background color. To change the background color, move the pointer to
one of the colors in the Palette, hold down the Command key at the
bottom left of the keyboard, and click with the mouse button. (In this
manual, we will refer to this as Command-elicking.) Note that
although the outer rectangle in the Color Indicator is now filled with
the new background color, the painting area itself is still the old
background color. This is because DeluxePaint assumes that you want
to maintain the old background color as a "wash" over the new
background color, and will keep it there until you clear the painting
area. Try it now: Click the button labeled CLR directly above the
Palette. This clears the screen of the old background color and
replaces it with the new one.

Above the Palette is the Toolbox, which consists of a number of squares
containing tools for creating your artwork (such as brushes of various
widths and shapes that you draw with). Before you do anything else,
let's get acquainted with one of the most important tools in the
Toolbox, the Undo button. Located to the left of the CLR button, the
Undo button will generally "undo" your last action, and is a hedge
against potentially disastrous mouse clicks and key presses. Click
Undo now to bring back the old background color. As a general rule,
Undo reverses your last action, provided there has not been an
intervening mouse click; so if you were to click CLR twice, for example,
clicking Undo would not reverse the Clear command.
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Figure 1.2 Toolbox and Palette

PAINTING WIlli THE MOUSE

Now that we've seen how to choose colors from the Palette, let's put
brush to "paper" and create our first drawing. Select a foreground and
a background color by clicking and Command-clicking on the palette.
Choose contrasting colors, such as blue for the foreground and yellow
for the background. Click CLR to cover your page with the background
color.
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Move the pointer to the top right square in the Toolbox and click on
the brush in the top right corner. Then move the pointer over to the
page (where it turns into a crosshair) and, while holding down the
mouse button, draw a figure on the screen. Don't worry about quality
for the moment - a squiggly line or a rough circle will do. Now hold
down the Command key and the mouse button and draw over your first
figure. This has the effect of erasing your drawing, although what
you are actually doing is painting over it with the background color.
The rule here is Simple: press the mouse button for painting with the
brush color, and press the Command key and the mouse button for
painting with the background color. Notice that this parallels the
rule we noted above for selecting colors from the Palette: select the
brush color by clicking with the mouse button and the background color
by Command-elicking with the mouse button.

Practice drawing with the mouse for a while. Remember, you can
always click Undo to reverse your last action, or CLR to clear the
screen and start afresh. As soon as you're ready, let's move on to the
next section, where we will be examining DeluxePaint's collection of
brushes and tools.

THE TOOLBOX

THE BUILT-IN BRUSHES

DeluxePaint includes ten built-in brushes at the top of the Toolbox
(refer to Figure 1.2): four round ones, four square ones, and two made up
of a number of separate pixels. (Pixels, short for picture elements, are
the small dots that make up the DeluxePaint screen. These are the
building blocks with which you create all artwork.) To select a brush,
move the pointer to one of the brush shapes and click with the mouse
button. Note that clicking a brush shape highlights it, indicating
that it is the currently selected brush. As we shall see, this convention
applies to all the other tOQls as well.

With your new brush selected, go ahead and paint as before, pressing
the mouse button to draw with the brush color and Command-pressing
the mouse button to draw (or erase) with the background color. If you
haven't already done so, try the three- and five-pixel brushes (the
ones below the eight solid brushes) and see what they can do. In the
next section we will be looking at the other drawing tools and seeing
how they interact with the brushes.
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THE TOOLS

The ten icons below the brushes (in two columns of five) control the
drawing tools that work in combination with the brushes and the
Palette. Because any brush can operate with any given tool, you have
a wide variety of brush combinations at your fingertips. To cancel one
tool, simply select another one. We'll describe the tools in order,
moving left to right and top to bottom:

THE DOTTED FREEHAND TOOL allows fast freehand drawing. No
matter how fast you draw with this tool, it keeps up with you, making
it ideal for sketching out a shape quickly before concentrating on the
intricate details. Note, however, that the faster you go, the bigger
the gaps in your drawing. Once you have roughed out a shape with
the Dotted Freehand tool, you can then refine your image using some of
the other tools at your disposal. Try drawing with it using some of the
other brushes to get a feeling for how it works.

THE CONTINUOUS FREEHAND TOOL. Because it produces
unbroken lines, but may not keep up with you if you draw quickly, the
Continuous Freehand tool is better suited for slower, more painstaking
drawing. Note, however, that the smaller the brush, the better it is
at keeping up. Try it with different brushes and see how brush size
and shape affect speed.

THE STRAIGHT LINE TOOL lets you draw straight lines by clicking
and dragging the mouse. Here's how it works: First, click on the
Straight Line tool to activate it, and then move the crosshair to the
point on the page where you would like the line to begin. Now press
the mouse button to anchor the line at that point, and, while holding
the button down, drag the mouse to the point where you want the line
to end. When you release the button, you have a straight line in your
selected brush color and brush size. Note that you can also draw
straight lines with the background color by holding down the
Command key as you press the mouse button.

THE CaRVE TOOL draws curved lines between two points in the
painting area. It works just like the Straight Line tool except that it
requires an additional mouse click to complete the process. Here's
how: Anchor the curve by pressing the mouse button, hold it down,
drag it to the point where you want the curve to end, and release the
button. Now, as you move the mouse away from the end points, you'll
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notice that the line is still "active," and will curve to follow the
crosshair wherever you drag it. As soon as the curve is the right
shape, click the mouse button to freeze it at that position. With a
little practice, you'll be able to make curves of any shape and size.
Try joining a series of curves to make flowing shapes with changes in
curve direction.

THE FILL TOOL fills any enclosed shape with the current foreground
or background color. To use the Fill tool, click the icon, move the cursor
(which now looks like a paintcan) to an enclosed shape, and click
again. You can fill the shape with the current foreground color by
clicking the mouse button, and with the current background color by
Command-clicking the mouse button. Note that the Fill tool fills all
the way to the boundaries of an enclosed shape. If the shape is not
completely enclosed (that is, if there is a hole in its perimeter), the
paint will "leak" through and fill the entire page. If this ever
happens, press the Spacebar to stop the filling process and remove the
fill you just inserted. (The Spacebar nips any ongoing process in the
bud and returns the screen to its pre-command state.)

It is important to realize which part of the paintcan cursor is the
"spout" - that is, which part needs to be within the enclosed shape
when you give the Fill command. This becomes important if you need
to fill a shape smaller than the paintcan cursor itself. The paintcan's
spout is the bottom of the splash pouring from the can. With careful
maneuvering, you can fill a space as small as one pixel by placing the
spout on that space.

TH~ AIRBRUSH TOOL is a full-featured airbrush with adjustable
tips and nozzles. By using the Airbrush in combination with the
different brushes, you can create a variety of effects, ranging from a
fine one-pixel spray to a coarse spray made with the big brushes. In
the follOWing chapter we will see how to adjust the size (radius) of
the spray, but for now let's try it as is. Click the Airbrush icon, and
then try painting with it using the various brushes. Try it with the
three- and five-pixel brushes, and then try it with the big brushes.
Note that, just like a regular airbrush, if you keep the mouse button
pressed without moving the mouse, the paint continues to build up in
one spot.
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THE RECTANGLE TOOL lets you draw squares or rectangles, either
unfilled or filled, with the current brush or background color. Note
that the Rectangle tool icon has a diagonal line running from its top
right to its bottom left corner. This is because it is actually two tools in
one - the top left one creates unfilled shapes, while the bottom right
one creates shapes filled with the current foreground or background
color.

Let's try making a few rectangles. Click the top left half of the icon.
Move the pointer onto the painting area (where it changes into a large
crosshair), press the mouse button to anchor one of the corners of the
rectangle, and, while holding the mouse button down, drag the mouse
away from the anchor point. You can drag the mouse down and to the
right (in which case the first button press anchors the rectangle's top
left corner), or in any other direction you wish. In any case, the
rectangle is completed as soon as you release the button. Note that it
is unfilled and bordered by the current foreground color. You can also
create an unfilled rectangle bordered by the background color: First,
Command-click another color on the Palette, then make a rectangle by
holding down the Command key while anchoring and dragging the
mouse as before.

To create a filled rectangle, click the lower right part of the Rectangle
icon and repeat the above procedure. This time, the rectangles you
create will be filled with either the foreground or the background
color, depending on whether you press only the mouse button or the
Command key and the mouse button when you create the rectangle.
Here are some other tricks you can try with rectangles:

Constraining. If you hold down the Shift key as you draw, you can
constrain the rectangle so that it is a square. This allows you to draw
squares easily. You can also use the Shift key with the Straight Line
and Polygon tools to constrain lines to horizontal and vertical lines.

Note: Because IIGS pixels are not perfectly square, "constrained"
rectangles will not appear square on the screen. Depending on your
printer, they might be square when printed, though. You can
compensate for the problem on the screen by selecting Square Aspect
from the Edit menu. See discussion in the Reference section under Edit
Menu.
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Leaving Traces. Holding down the CTRL key while using the
Rectangle tool paints traces as you draw. In other words, as you drag
the mouse to paint a large rectangle, DeluxePaint also paints the
intermediate rectangles. You can also use CTRL to create traces with
these other tools: Straight Line, Curve, Circle, Ellipse, and Polygon.

THE CIRCLE TOOL works like the Rectangle tool, above: Click the
top left part of the icon to get an unfilled shape, or the bottom right to
get a filled shape. Move to the painting area, then press and drag
with the mouse button to create a circle with the current foreground
color, or hold down the Command key and press and drag with the
mouse button to create a circle bordered (or filled) with the current
background color. When you release the button, DeluxePaint draws
your circle. (Note: Because lIeS pixels are not perfectly square, circles
will not appear perfectly round on the screen. You can compensate for
this problem by selecting Square Aspect from the Edit menu.)

THE ELLIPSE TOOL works just like the Circle tool, except that it is
stiII "active" after you release the mouse button. First you size your
ellipse; then (if desired) you rotate it. Try it. Click the icon with the
mouse button (remember, top left for unfilled, and bottom right for a
fiIIed shape), move the pointer to the painting area, and draw an
ellipse by pressing the button and dragging the mouse. Now release
the button. Note that even though you have released the button, the
ellipse continues to change shape as you drag the mouse around. By
doing so, you can make the ellipse any shape you like. As soon as it is
just the right shape and size, click the mouse button again to draw your
eIIipse. Or, to change the orientation of your ellipse, press and hold
the button down instead of clicking it, rotate the ellipse about its
center, and release the button when the orientation is just right.
DeluxePaint then draws your ellipse, and the smaIl crosshair changes
into the large crosshair to let you know that it is ready for your next
command.

THE POLYGON TOOL lets you keep drawing straight lines until you
have created a closed figure. Here's how it works: Click the Polygon
tool, move the crosshair into the painting area, and click the button
once to anchor the starting point of your polygon, and then a second
time to complete the first line, as if you were using the Straight Line
tool. This time, however, you will notice that your crosshair is stiII
connected to the first line by a second straight line. Click the button
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again to finish the second line, and so on until you have completed
your polygon. The polygon is completed as soon as you click the button
with the crosshair on your starting point. If you are creating a filled
polygon, it will be filled with the current foreground color if you
complete the figure with a click, and the current background color if
you complete it with a Command-elick.

Because it can sometimes be a little tricky to click on the exact pixel
you started with, you can complete a polygon at any time by pressing
the Spacebar. This automatically connects the last anchored point to
the point of origin and, if it is a filled polygon, fills it with the
current foreground color. Try drawing some five-pointed stars with the
ffiled Polygon tool and see what happens.

ANYfHING CAN BE A BRUSH

We'll skip over the rest of the tools for now, except one. (We'll be
covering the remaining tools in Chapter Two.) The icon just below the
Ellipse is the Brush Selector, a special tool that is an essential part of
DeluxePaint's versatility. With the Brush Selector, anything can be
a brush - any piece of artwork or text you put on the screen. To see it
in action, click the icon, then move the cursor over to the painting
area. Notice that your cursor is now a large crosshair that reaches to
the edges of the screen.

Select one of the stars you made earlier by putting the center of the
crosshair to the upper left of the star. Then, while holding down the
mouse button, drag the cursor to the lower right of the star, as if you
were using the Rectangle tool to enclose the star in a box. When you
release the mouse button, the cursor now has a copy of the star
attached to it. This second star is your new brush! To stamp a star in a
new location, click the mouse button. There's no need to stop with one
- go ahead and star-spangle the screen. We will be covering this
powerful feature in greater depth in Chapter Two. For now, however,
there is one aspect of brush selection you should be aware of: if any
parts of your brush consist of the current background color, those parts
will be transparent. In other words, whenever you pick up a brush, the
background color in the brush will be invisible, provided that color is
the currently selected background color.

1.11



CHAP TERON E: A GUIDE D TO UR

Let's try one more trick. Click the Brush Selector again and select a
star from the painting area, but this time hold down the Command
key and press the mouse button to drag the crosshair over the star.
Unlike the last exercise, which yielded two stars - one unmoving
original, plus the one on your brush - this time you are picking up and
moving just the one star. While the first feature lets you copy and
move anything on the screen, the second lets you move images from one
part of the screen to another, while leaving no trace behind.

To change from a custom brush, create another custom brush or click a
built-in brush at the top of the Toolbox.

mGEmNG GOING

SAVING YOUR WORK

Before we move on to the next chapter, where we'll be looking at
DeluxePaint's basic elements, let's see how to save and load the
pictures (or "files") you create. First, let's learn how to save a file, just
in case you feel that the recent exercises were a first step towards a
masterpiece. Even if you don't feel quite this way about your creations
yet, you might want to follow along for future reference.

DeluxePaint provides access to hundreds of additional features that
are not constantly visible like the Palette and the Toolbox. These
features (which include loading and saving, among others) are
available through a series of pull-down menus in the Menu Bar at the
top of the screen.

As you move your pointer from left to right along the Menu Bar (while
holding down the mouse button), one after another of the menus
extends down, each one displaying its selection of options. We will be
looking at each menu item in detail later, but for now we just need to
use the same options on the File menu. So, move the pointer to the
word File at the left of the Menu Bar and hold down the mouse button
to produce the File menu options. With the button still held down,
move the pointer down to Save Picture, the second item on the list of
options, and release the button. This results in a Save Picture Dialog
Box (see Figure 1.3). It is through the Save Picture Dialog Box that
you provide DeluxePaint with the information it needs to save your
files.
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® /DPaint/
Free: 723k out of BOOk. ( Cancel )

L'l!~~¥

~
(New Folder)

( Close )

( Disk )

Save Picture: ( o", ~'f'" )INewPicture ¢ Save »
Figure 1.3. Save Picture Dialog Box

At the top of the dialog box is the name of your disk and the amount of
storage space remaining on it. Below that is a list of foldernames and
filenames. You can scroll through these names (not all of them are
always visible at one time) by dragging the scroll box up and down.
(The scroll box is the white rectangle within the scroll bar, the
vertical column to the right of the filenames.) Just point to the scroll
box, press the mouse button, and drag it up or down. As soon as you
release the button, new names will appear in the dialog box. You can
also scroll through the names one at a time by clicking the up and
down arrows at the top and bottom of the scroll bar.

Now is your chance to save your current creation as a new file. If you
are using only one disk drive, eject your working copy of the
DeluxePaint disk and replace it with a blank initialized disk. Then
click in the Save Picture box, type the name you have chosen for your
new file, and click the Save button at the bottom right of the dialog
box. (To save a file in a folder, first click on the folder and click the
Open button to open. Then type a new filename in the Save Picture box
and click the Save button.)
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If you are using two drives, save your picture as follows: Put the data
disk in drive 2, click the Disk button on the right of the dialog box
until you get to the drive 2 disk, click in the Save Picture box, and type
the filename. Click the Save button to complete the process.

The next time you save this file (it's a good idea to save work in
progress every 15 minutes or so, so that a power failure or other
mishap doesn't turn hours of work into a bitter memory), the Save
Picture Dialog Box uses this same information, which means you won't
need to type anything more unless you want to change the filename.
You might want to do this to save it under another name, if you want to
save each version as a separate file. In that case, you would click the
Save Picture box as before, delete the old filename (or those parts you
wish to change) and type the new name. Or you could just keep adding
suffixes, such as 1, 2, 3, to signify succeeding versions.

LOADING A PICTURE

Now that we've seen how to save a file, let's see how to load one of
the pictures on your disk. Let's load the one called Seascape. First,
move the pointer up to the Menu Bar and to the left to the File menu.
Press the mouse button to extend the menu, and then select Load
Picture. This time you are presented with the Load Picture Dialog Box
(see Figure 1.4).

Load Picture:
® /DPaint/

. ... ~ ( Disk )
D Brush

U Open »
( r; ! f)~' .!' )

~ ( )Cancel

Figure 1.4. Load Picture Dialog Box
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Note that the Load Picture Dialog Box is similar to the Save Picture
Dialog Box. If you're using only one disk drive, make sure you have
inserted the DeluxePaint art disk in your drive. If you're using two
drives, click the Disk button until you get to the drive containing your
DeluxePaint art disk. When you see the name of the art disk at the
top of the dialog box, scroll to the folder or file you're looking for.
Let's load the sample file Seascape: First open its folder (Med.Res) by
clicking the folder name and then the Open button. (You can also open
a folder or file simply by double clicking the name.) Then click the
filename Seascape and the Open button. The disk drive will spin for a
few moments, and then the picture will appear on the screen. (To close
an open folder and return to the previous list of files and folders, click
the Close button.)

NIGHT AND DAY

Take a few moments to examine the picture carefully. Note, for
example, that the palette is different from the one we were using
before. This is because the new picture comes with its own palette,
which supersedes the old one. You can revert to the default palette at
any time through a Simple menu selection. Let's try it now and see
what happens. Pull down the Color menu and drag the pointer down
to Default Palette, then release the button.

Did you see what happened? The new palette was replaced by the
default palette, making the picture change from night to day! If you
want to restore the original palette, return to the Color menu and drag
down to Restore Palette. When you release the button, the palette
reverts to the original. This is just one example of the many ways you
can make global (and dramatic) changes to a picture with just one
action.

FDaNGTHEBACKGROUND

Let's try one more trick before we move on to the next section. Click the
CLR button once to clear the screen, and then click Undo to restore the
picture. (If you clicked CLR twice, Undo will not work to restore the
picture. You will need to load it again.) Now open the Pict menu, drag
down to Fix Background, and release the button.
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What you have just done is remarkably simple, and yet remarkably
powerful. You have fixed the picture onto the background so that it
cannot be removed. Try it. Click CLR as you did before and see what
happens. That's right - nothing. The picture is fixed, which means
you can draw over it any way you like, and then click CLR to restore it
to its original form. Go ahead, select a thick brush and draw all over
it. Do it with the airbrush if you like. Then click CLR for the easiest
art restoration job ever.

Note that you can continue fixing the background each step of the way,
with each "fix" stamping the entire picture into the background. This
way you can erase everything you did since the last fix with a single
mouse click. And you can "unfix" the background just as easily as you
fixed it: just go to the Pict menu and drag down to Free Background.
This restores everything back to normal, so that clicking CLR clears
the entire picture.

We will be looking more closely at this feature in the next section
when we look at custom brushes and the way they interact with the
background. Meanwhile, feel free to experiment further with this
feature. Art restorers should hav-e it so easy.
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In this chapter we examine the fundamental "elements" that make up
DeluxePaint. If you have some experience with computer graphics
software, you may want to use this chapter to learn how DeluxePaint
handles features you may have encountered in other programs. As
with any other part of this manual, however, you should feel free to
read sections in any order you wish.

We have classified the elements as follows:

The Custom Brushes examines DeluxePaint's custom brush
capabilities. This part looks at the various techniques available for
modifying a brush, such as resizing, flipping, and, by entering
Perspective mode, rotating it about its three spatial axes.

The Screen deals with all those techniques that affect the entire
DeluxePaint screen, such as switching pages, magnifying and zooming,
gridding, symmetry, screen resolutions.

The Palette looks at DeluxePaint's color m1Xlng and color cycling
capabilities, and examines how color availability relates to screen
resolution.

The Tools looks at advanced tool techniques, and shows how to
customize some of the standard tools to create just the right tool for the
job.

The Painting Modes deals with the various ways you can affect paint
once it is already on the page, such as smearing, blending, or smoothing
it to give you special effects.

Text shows how to use DeluxePaint as an elementary word processor,
showing how to select fonts, how to enter text, and how to move it
about the page.

Many of the techniques discussed in this chapter are also covered in
the tutorials in Chapter Three. If you prefer to learn by doing, you
may want to work through the tutorials first, and then refer to the
relevant parts of this chapter if you need more information. Or you
may want to read this chapter first to understand how DeluxePaint is
structured, and then try some of the tutorials to see how it works in
practice.
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o THE CUSTOM BRUSHES

As we saw in the Guided Tour in Chapter One, DeluxePaint's
"anything can be a brush" feature lets you select any image on the
screen and use it as a brush. Thus, you can keep a selection of images on
your spare page (the second page that is available in any DeluxePaint
painting) and move the images over to the main page by picking them
up as brushes. In addition, you can load and save brushes as separate
files in the same way you load and save pictures.

CREATING A BRUSH

To create a brush out of an on-screen image, click the Brush Selector
(the tool to the left of the Text tool) and then drag the large crosshair
to form a rectangle around the image. When you release the mouse
button, an exact copy of the image is attached to your arrow cursor.
You can now paint with your new brush just as you would with any of
the built-in brushes.

As we saw in the Guided Tour, when you drag the Brush Selector
rectangle around an on-screen image using the mouse button,
DeluxePaint makes a duplicate of the image and attaches it to the
arrow cursor, while leaving the original image in place on the page.
We also saw that if you hold down the Command key and press the
mouse button to surround the image, the image itself becomes the
brush, as if the original image had been lifted up off the page. This
technique provides an ideal method for picking up objects and moving
them around the page as you experiment with different compositions.
In particular, if you use the Fix Background menu option (which we
also covered in the Guided Tour) and then create images on top of the
fixed background, you can lift any of these images off the background
using the Command key and mouse button. DeluxePaint "remembers"
those parts of a fixed background that are covered by unfixed shapes,
so that you can move the shapes around the page and uncover the
previously hidden background.
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SELECTING COMPLEX SHAPES

As we saw earlier, clicking the Brush Selector once with the mouse
button lets you draw a rectangle around any image on the page.
Clicking the Brush Selector a second time lets you "corral" any image,
thereby letting you pick up shapes from a crowded background. To
corral an image, move the arrow cursor and click around the shape you
wish to define, just as if you were describing a polygon around it with
the Polygon tool (see "The Toolbox" in The Guided Tour). As soon as
you complete the selection polygon, the complex shape becomes your
new brush. To corral and duplicate the shape, create your selection
polygon by dragging and clicking the mouse button. To corral the
shape and pick it up off the background, create your selection polygon
by dragging and Command-clicking the mouse button. Note also that
this corralling function works just like the Polygon tool in one more
important respect: pressing the Spacebar completes the selection
polygon for you, so you don't have to search for the starting pixel in
order to complete it.

THE BACKGROUND COLOR IS TRANSPARENT

When you create a custom brush (with either method described
above), you will notice that any part of the brush which matches the
current background color appears transparent. For example, if you pick
up a round object sitting on the background color, you pick up part of the
background as well (because the Brush Selector picks up rectangular
shapes), but when you move your new brush over to a contrasting object,
the brush contours will appear round and not rectangular. This is
because DeluxePaint treats the current background as transparent.
Whenever you are using a brush and want a color in the brush to be
transparent, simply select that color as the current background color (it
will be displayed in the Color Indicator). Change background colors to
make a different brush color transparent. This feature lets you create
a brush out of a complex image (such as intricate lace, for example)
and then see through it to other objects behind the brush.
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A BRUSH IS A LITTLE PICTURE

Because a brush can be as complex as you like, you can treat brushes just
like full pictures. When you load a saved brush, it comes equipped
with its own palette, the one that was in effect when the brush was
first saved. If the current picture is using a palette different from that
of the newly-loaded brush, you can change the current palette to the
brush's palette by selecting Use Brush Palette from the Color menu.
On the other hand, if you want to use the newly-loaded brush with
the current palette, select Remap Brush from the Color menu. The
Brush menu lets you resize and reshape brushes in various ways. See
Tutorial Two for a series of exercises in modifying colors and shapes of
brushes.

Your DeluxePaint disk contains a number of saved brushes, in addition
to the ones used in the tutorials. To load a brush, select Load Brush
from the File menu. This brings up a Load Brush Dialog Box, similar
to the Load Picture Dialog Box we used when we loaded a picture in
the Guided Tour (see Chapter One). Make sure the name of the
DeluxePaint art disk appears at the top of the dialog box. Open the
Brush folder and experiment with some of the saved brushes. Select
Use Brush Palette whenever you load a brush to ensure that you are
seeing it as it was when it was saved. Load the brush called Bobsled,
for example, and try drawing with it. You'll soon realize why it's
called Bobsled. You might also try the one called Fireworks, but this
time select Multi-Cycle and Cycle from the Mode menu, and then press
the Tab key before you start drawing with it. Fireworks comes
complete with color cycling information, and is a spectacular example
of the power of this feature. See Tutorial One for more demonstrations
of color cycling.

ADDITIONAL FEATURES

The following are some additional features relating to custom brushes:

BRUSH HANDLE: This feature, which is available from the Edit
menu, allows you to specify whether your arrow cursor will sit at the
center of your custom brush, or at one of its corners. In the default
setting (when the Brush Handle is not checked on the Edit menu), the
arrow cursor sits at the center of the custom brush and you can hold the
brush directly by its center. When you select Brush Handle from the
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Edit menu and create a brush, you hold your brush by a ''handle'' on one
of its corners. If you create your brush by dragging downward from
upper left to lower right, the brush handle will attach itself to the
lower right-hand corner, whereas if you create the brush by dragging
from lower right to upper left, the handle will attach itself to the
upper left-hand corner. The rule is simple: the brush handle attaches
itself to the ending comer in the brush creation process. The Brush
Handle option becomes important when you enter Perspective mode
(see below), because you can rotate a brush about its center or its
handle.

PERSPECTIVE: DeluxePaint's Perspective option (available through
the Brush menu) lets you rotate a custom brush about any of the three
axes of three-dimensional space to define a plane of operation, and
then work within that plane to create perspective effects. Here's a
quick overview of how to use Perspective: You pick up a custom brush
and select Perspective from the Brush menu. This turns your brush into
the Perspective Brush outline, a rectangle frame with a cross in the
middle. Using Perspective commands described in the Reference
section, you can manipulate the Perspective Brush outline by rotating
it about its three axes or by moving it closer to or further away from
the observer. Once you define the plane of operation, moving the
mouse moves the Perspective Brush outline along that plane, in three
dimensional space. Clicking the mouse button places a full-eolor,
perspective version of the original brush onto the defined plane.

Perspective is the subject of the fourth tutorial in the following
chapter. To get the most out of this special feature, we recommend you
work through the exercises in that tutorial. You can also consult
Chapter Four, the Reference section, for more information on
perspective.

FAST FEEDBACK: This feature, which is available from the Edit
menu, allows you to draw lines, filled shapes, or unfilled shapes with
a complex brush; but with faster feedback. With Fast Feedback
selected, when you draw a line or shape with a custom brush, all you
see is a one-pixel line or outline until you finish drawing, at which
point your line or shape is repainted with the current brush. When
Fast Feedback is selected, a check appears next to it on the menu.
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f) THE SCREEN

Some of DeluxePaint's features affed the entire screen, while others,
such as the tools and the brushes, affect the screen selectively. This
section considers those features that have a screen-wide effect.

INFO BAR

The Info Bar at the bottom of the screen displays information about
your status. Select Info Bar from the Edit menu or press 9 (use the
number key on the main keyboard, not the keypad). The Info Bar
shows you the current Mode setting (such as Matte), the current
pattern, gradient, or perspective fill, an S if you have a stencil on, and
a B if your background is fixed. If you have selected Coordinates from
the Edit menu, the Info Bar shows the x and y coordinates of your brush
location. If you're in Perspective mode (and Coordinates is turned off),
the Info Bar also shows the amount of rotation about your three axes.

To hide the Info Bar again, select Info Bar from the Edit menu or press
9.

HIDING THE TOOLS AND THE MENU BAR

DeluxePaint lets you paint on the entire screen, even under the
Toolbox/Palette and the Menu Bar. To clear these from the page, press
the 0 (zero) key (use the number key on the main keyboard). Press the
same key a second time to bring these back.

You can access the tools, even with !he Toolbox hidden, through the
keyboard equivalents. See the Reference section of this manual or your
Reference Card for a list of keyboard commands.
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MAGNIFYING AND ZOOMING

You can magnify any section of your work, and view it alongside the
standard-sized image. To magnify a section of your work, click the
Magnify icon (the one that looks like a magnifying glass, above the
Undo icon). When you move the cursor onto the page, it becomes a
rectangular outline. Move the outline to the part of the image you
want to magnify, and click the mouse button. The part of the image
included in the rectangle now appears magnified on the right part of
the screen. The left part of the screen shows the image in its original,
unmagnified form. Another way to enter the Magnify mode is to move
your cursor to the area you want to magnify, and press the m key.

You can now carry out any functions on either side of the screen using
any of the tools in the Toolbox. Thus, you can draw circles and squares,
fill in shapes using the Fill tool, and use any of the brushes normally
available to you. Using the four arrow keys, you can move the image
around under the "magnifying glass." In addition, by pointing your
cursor anywhere on the unmagnified or magnified portion of the screen
and pressing the n key, you can center that part of the picture in the
magnified area.

Once you have magnified a part of your picture, you can increase or
decrease the amount of magnification by using the Zoom function (the
Zoom icon is the one to the right of the Magnify icon). Click the top
left half of the Zoom icon (the Up Arrow) to increase the
magnification, and click the bottom right half of the Zoom icon (the
Down Arrow) to reduce the magnification. DeluxePaint's Magnify and
Zoom tools let you carry out precision work on your pictures by
magnifying each pixel up to 16 times its original size.

To quit Magnify mode when you have the magnified area on the
screen, click the Magnify icon a second time.

GRIDS

The Grid lets you apply paint on the page in accordance with an
invisible grid. The Grid also restricts your drawing tools to the grid
points. As an example of drawing on a grid, click the Grid icon
(directly above the Magnify icon) and then click the Dotted Freehand
tool. With Grid and the Dotted Freehand tool selected, you can paint
only on the points of the grid, making it easy to fill the screen with a
polka-dot pattern, for example (we shall see other methods for
pattern design later).
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Grid works with all tools except the Continuous Freehand tool. For
example, if you use Grid with the Rectangle tool, you can put down the
corners of your rectangles only at grid points.

You can also control the spacing between the grid points. Command
click the Grid icon to bring up the Grid Dialog Box (see Figure 2.1).
You can now set the spacing for the X and the Y coordinates to match
the dimensions of your brush by clicking From Brush. Or you can type
the actual spacing in the X-Spacing and Y-Spacing boxes. Note that
the spacing is calibrated in pixels. To enter a new value, dick
anywhere in the calibration box, delete the existing value, and then
type in the new value. When you are satisfied with the new values,
click OK. If you want to retain the old values and return to your work
without making a change, click Cancel.

Grid

X-Spacing: 1m I
V-Spacing: Is I

( Adjust) ( From Brush)

¢ OK D (Cance 1 )

Figure 2.1. Grid Dialog Box

You can also recalibrate the gridding by using a visual method (as
opposed to the above numerical method). If you click Adjust in the
Grid Dialog Box, you will return to the painting screen with a cursor
that looks like a 4 x 4 matrix. This matrix represents the current grid
values in graphic form. To resize the grid visually (and hence change
the x and y grid values), press and hold down the mouse button, drag
the mouse until the matrix is the desired size and shape, and then
release the button. The new grid is based on this matrix. You can also
reposition the points of the grid using Adjust: Move the matrix so that
its cells are in the desired position and click the mouse button. Note:
To set a grid point at a specific coordinate, first turn on the Info Bar
and Coordinates (on the Edit Menu).

If you have the grid on and plan to pick up an image as a brush to
create a continuous pattern, you might want to select Excl Brush before
you pick up the brush in order to eliminate a one-pixel border on the
right and bottom edges of the image. (For details, see Excl Brush under
the Edit Menu in the Reference section.)
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To change the Symmetry tool's values, Command-elick the Symmetry
icon. This brings up the Symmetry Dialog Box (see Figure 2.2).

The Symmetry tool lets you paint symmetrically over the entire page
at the same time. To paint symmetrically, click the Symmetry tool
(the one to the right of the Grid tool). With Symmetry selected, your
brush is made up of a number of mirror images of itself. As you move
the brush around, all the mirror images move as well, producing an
effect much like that of a kaleidoscope. When you paint in Symmetry
mode, you are laying down a number of identical mirror images about a
fixed origin. In all cases except the Dotted and Continuous Freehand
tools, the mirror images are drawn after you release the mouse button.
With the Dotted and Continuous Freehand tools, all the images are
drawn at the same time.

The Grid tool is useful for precise cursor placement of images and
makes it easy to create repeating patterns, parallel lines, and other
repetitive designs. To turn off the Grid tool, click the icon a second
time.

If you are in Perspective mode and you Command-dick the Grid icon,
the resulting dialog box lets you adjust the spacing for the third
dimension as well (Z-spacing). The dialog box also lets you specify the
angle of rotation of your brush about the three axes (called the Angle
Step). See the discussion of the Grid tool in the Reference section for
more information.

SYMMETRY
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Point means that the symmetry occurs about a single central point
(which you can define). The Point Order box specifies the order of the
symmetry, that is, how many times the basic image is repeated about
the central point. To change the order, click in the Order box, delete
the existing value, and type in the new value. You can use any order up
to 40. Place Point Center lets you position the central point of your
symmetrical pattern. To reposition the central point, click Place Point
Center, move the large crosshair to the new location, and click the
mouse button. Subsequent symmetrical drawing will be centered on the
new location.

If you select Point Symmetry, you have two options - Mirror or Cyclic.
Mirror means that each brush head has a related twin that mirrors its
actions. Try using Mirror: Select Point and Mirror, change Point Order
to 4, click OK, and draw a small rectangle on the screen. Note that the
result is a total of 8 rectangles on your page.

Cyclic, like Mirror, lets you draw about a point with a number of
brushes (also determined by Point Order), but the effect is different
from the Mirror option. In Mirror, each brush has a twin: if your order
is four, you have eight drawing points on the page, with the two
points in each pair reflecting each other's actions. In the Cyclic mode,
there are no pairs: If your order is four, there are four brushes on the
page. The pattern produced by each brush is not itself symmetrical
because it does not create a mirror image of itself as you draw. Try it
and see.

Tile lets you draw with a number of brushes at the same time, but
without mirroring them about a central point. Instead, Tile creates a
number of images on a grid, making it easy to create groups of identical
images in a regular pattern. To draw in Tile mode, click Tile in the
Symmetry Dialog Box. You can then specify the distance in pixels
between each point, for both the x-axis (width) and the y-axis
(height). Whenever you select the Symmetry tool from then on (until
you change it again), you will be painting with a series of regularly
spaced brushes. Because Tile lets you create an entire pattern just by
drawing one of its elements, it is an ideal tool for textile designers.
Together with Pattern Fill (discussed below), Tile can make a textile
designer's life considerably easier. Try using Tile: Select Tile and
draw a small rectangle on the screen. Note the regular-spaced pattern
of rectangles that results.

Finally, as with any other dialog box, click OK to use the current
setting and return to your picture, or Cancel to return to your picture
without effecting any change. To turn off Symmetry, click the icon a
second time.
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THE PAGES

DeluxePaint gives you two separate and relatively independent pages
to work with. You can use one of the pages for creating background
images, and the other for creating foreground images. You can then
move parts from one page to the other, or within each page until the
composition is just right. As we shall see in a moment, the two pages
are not entirely independent. For one thing, they share a common
Palette, almost as if they were the same picture.

SWITCHING PAGES

When you first open a new file or load a picture from disk,
DeluxePaint opens one of the two pages. To move from one page to the
other, press the j key, or select Spare Page from the Pict menu. When
you do, you will notice that the Palette you were using in the first
page follows you to the second page. This means that if you modify
the Palette for one page and then switch to the other page, you end up
modifying the second page's Palette as well. Note, however, that
although the two pages share the same palette, you can have a
different background color on each page. (Note: If your two
background colors are different, your brush's transparent areas will be
different if you move it from one page to the other.)

In addition, because the Toolbox is not really part of the page (but
actually sits "above" it), whatever tools you had selected before you
switched will still be selected after you switch pages. This way, you
can retain the same tool settings, giving you continuity as you work.
Note that the Fix Background option and the Stencil options do not
carryover from one page to the other. See the following section for
information on fixing the background, and Tutorial Three in the next
chapter for exercises involving the Fix Background and Stencil
features.
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FIXING THE BACKGROUND

As we saw in the Guided Tour, the Fix Background option (from the
Pict menu) lets you fix whatever is currently on the page as a
background. When you have a picture fixed as a background, you can
return to it at any time just by clicking CLR in the Toolbox. This is
because CLR always clears to the background (which under normal
circumstances is simply the background color), so when you have a
picture fixed as a background, CLR clears to that. This means that you
can try daring innovations on a fixed background, and then return to
the original picture with just the click of a mouse. Or you can paint
while holding down the Command key and the mouse button to erase
anything you have added since the fix.

In addition, you can pick up any part of the recent additions to a fixed
background with the Brush Selector (see Custom Brushes, above) and
reposition them anywhere on the page. Note, however, that if you fix
the background and then add more paint, you can only pick up those
portions of the newly-added paint that are not the same color as the
current background color.

PAGE SIZE

The Page Size option on the Pict menu lets you specify the finished
size of your painting (called the page size). When the Set Page Size
Dialog Box appears (refer to Figure 4.2), you can select Screen Size to
make your painting the .size of the screen. Or you can select Custom
Size, where you can specify any desired page width and height (in
pixels). The maximum painting size is twice the area of your screen
(for example, in Medium Resolution, 320 x 400, 640 x 200, or any other
size up to twice the screen area).

If you are working on a page size larger than the screen, you can scroll
to the off-screen portions using the four Arrow keys. You can also
preview the entire page at any time by selecting the Show Page option
from the Pict menu. Return to your current page by clicking the mouse
button.
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SCREEN RESOLUTIONS

To change screen resolution, select Screen Format from the Pict menu.
The two resolution formats are described as follows:

320 x 200, 16 colors <Medium Resolution): This format uses a pixel
array 320 wide by 200 high, and can accommodate 16 colors on the
screen at the same time.

640 x 200, 4 colors (High Resolution): This format uses a pixel array of
640 by 200, using pixels that are the same height as the Medium
Resolution ones, but only half as wide. High Resolution limits the
number of colors available for a single picture to 4.

Choose Screen Format

@ 320 x 200, 16 colors
061.10 x 200, 1.1 colors

¢ OK l) (Cancel)

Figure 2.3. Choose Screen Format Dialog Box

You cannot change the resolution of your picture while it is on the
screen. Likewise, you cannot load a picture that was saved in a
different format.

Note: If you try to load a picture that is in IIGS screen-dump format
using either medium resolution or high resolution format, DeluxePaint
warns you that the picture was saved in another format before loading
the picture.

IJ THE PALETIE

THE PALETIE AND SCREEN FORMATS

As we noted above, DeluxePaint contains a universe of 4096 colors. In
the (default) Medium Resolution format, you can use 16 at any given
time. High Resolution format allows four colors on the screen at one
time. When you first start DeluxePaint, the default palette appears
below the Toolbox. (To customize this, see the Palette Window
below.) When you load a picture, DeluxePaint loads the palette you
used when you painted the picture and displays it below the Toolbox.
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THE PALETIE WINDOW

To bring up the Palette Window, either Command-dick the Color
Indicator, press the p key, or select Palette from the Color menu.
(These methods all produce identical results). The Palette Window
(see Figure 2.4) lets you mix your own colors for a custom palette which
then appears in the main Palette (below the Toolbox). From a
universe of 4096, you can create 16 different colors in Medium
Resolution and four colors in High Resolution. The 4096 figure is
derived from the fact that any given color can be expressed in terms of
its Red, Green, and Blue (RGB) components. With 16 possible shades
in each component, the possible universe of colors comes to 16x16x16, or
4096.

In the Palette Window is the mixing palette, a copy of the main
Palette. The current color (the color that you are now working with) is
surrounded with a black rectangle called the Color Selector. As you
modify Hte current color, you can watch the color change in the mixing .
palette.

000 000
Range:@ 1 0 2 0 3 0 ~

Speed:1 01 91@~O1'

( Spread) ( Swap) ( COpy)

([ OK » (Cancel)

Figure 2.4. Palette Window
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The RGB method of color mixing lets you blend Red, Green, and Blue to
produce the desired shade. The HSV method provides an alternative
approach to color mixing, but with identical results. The HSV method
breaks each color down into its Hue, Saturation, and Value. Hue refers
to the color's position on the color spectrum or rainbow. As you move
the scroll box down the Hue scroll bar (starting from the top), your
current color changes to a shade of the following colors - Red, Purple,
Blue, Green, Yellow, Orange, and Red. Saturation refers to the
strength of a particular hue - whether it is relatively pure (and
hence highly saturated), or whether it contains some proportion of
white. Thus, the more white, the less saturated. Value refers to a
color's black level (and hence the amount of light it would reflect off a
surface). A color with a high value would have little or no black,
whereas colors with low value would contain more black. Irrespective
of Hue and Saturation, a Value of zero produces a pure black.

DeIuxePaint lets you mix colors with either method. It also lets you
create color spreads to give you subtle shades of the same hue. You can
learn about the Palette Window by working through the tutorials in
the next chapter (where you will create your own custom palette), or
by reading the relevant parts of the Reference section (see Palette in
the Color menu). For the time being, just be aware that you can modify
the currently selected color on any of the six variables (R, G, B, or H, S,
V) by dragging the appropriate scroll box up or down its range. As you
do so, note that the two sets of variables are related - for example,
after you move the RGB scroll boxes, the HSV scroll boxes respond
accordingly. Note that when you modify a color in the Palette
Window, all occurrences of that color are also changed on the painting
screen and the color is immediately changed on the main Palette
(below the Toolbox).

The Palette Window also lets you create color spreads to give you
subtle shades of the same hue or equally spaced gradations across
hues. To create a spread of colors, click the first color, click Spread,
and then click the last color. DeluxePaint looks at the first and last
colors in the spread and at the number of steps in between, and
calculates the series of intervening shades. For example, if your first
color is a highly saturated red and your last color is a pure white,
with ten steps in between, you will end up with a spread of twelve
colors ranging from red to white separated by varying shades of pink.
Likewise, if your first color is blue and your last color is yellow,
DeIuxePaint calculates the intervening shades and hues, to give you a
series of blues, blue-greens, greens, yellow-greens, and yellows. And
unlike traditional color mixing, if your modifications are not to your
satisfaction, you can always reverse the last change by pressing u on
the keyboard (for Undo), or you can cancel all the changes you made by
clicking the Cancel button in the Palette Window.
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Swap and Copy let you swap or copy colors from one part of the Palette
to another. If you click a color in the Palette Window, click Swap, and
then click a second color, the two colors will change places on the
Palette. Similarly, if you click a color, click Copy, and click a second
color, the first color will be copied onto the second. By letting you
place colors anywhere on the Palette, these two functions make it
easier to create the color spreads you need for your work.

The Palette Window's Range function plays an important role in
several DeluxePaint features, in particular, Color Cycling and
Gradient Fill, both of which are treated extensively in the tutorials
in Chapter Three. As its name implies, Color Cycling cydes through a
defined range of colors to produce simple animation effects. You can
define up to four color ranges (one for each of the radio buttons labeled
1 to 4), and you can assign a cycling speed to each one. You define a
range using the vertical bracket to the right of the palette in the
Palette Window. To set a range, click one of the numbers after Range
(for example, 1). Then click one end of the Range bracket and drag it to
the first color in the range; drag the lower Range bracket to the last
color in the range. See Tutorial One for detailed instructions on
creating animation effects using Color Cycling.

DeluxePaint's Gradient Fill function also makes use of the Range
information. The currently selected range (a range is selected when
one of its members is selected) determines the colors or shades that
will be used in a gradient fill. By using a gradient (as opposed to a
standard solid) fill with a carefully chosen color spread, you can
create shading effects that would make an airbrush artist envious.
See Tutorial Two for instructions on gradient fills.

DeluxePaint also uses Range information for some of its painting modes
(specifically Blend and Shade), which are available through the
Mode Menu. See "Painting Modes" below for information on this
feature.

For a list of keyboard equivalents for activities performed in the
Palette Window, see the Reference section.
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II THE TOOLS

DeluxePaint's painting tools are available through the Toolbox, the
panel on the right-hand side of the screen. As we have already seen,
you can activate any tool by clicking its icon with the mouse button. A
tool remains active (and its icon highlighted) until you select another
tool or, in some cases, until you deselect it by clicking the icon a second
time. Examples of the latter kind of tool are the Grid and the
Symmetry and Magnify tools, which are toggled on and off by each
mouse click.

MODIFYING TOOLS

In most cases, holding down the Command key and clicking the mouse
button on a tool icon (Command-<:licking) lets you modify some
fundamental aspect of that tool. The following summarizes the effects
of Command-<:licking the tools in the Toolbox:

THE BUILT-IN BRUSHES: You can change the size of any of the built
in brushes at the top of the Toolbox by Command-<:licking a brush,
moving the cursor over to the painting area, and then dragging
diagonally while holding down the mouse button. Release the mouse
button when the brush is the desired size. This applies not only to the
eight solid brushes, but also to the three- and five-pixel brushes below
them.

THE AIRBRUSH: The Airbrush works with any of DeluxePaint's
built-in brushes, or with a custom brush of your own creation. You can
adjust the Airbrush's nozzle by Command-<:licking the Airbrush icon,
moving the cursor over to the painting area, and then pressing the
mouse button and dragging diagonally to adjust the size of the solid
circle, which represents the spray area. Release the mouse button
when the solid circle is the desired size.

STRAIGHT LINE AND CURVE TOOLS: A Command-click on either
of these tools brings up the Spacing Dialog Box (see Figure 2.5),
allowing you to create either straight or curved dotted lines. The
Spacing Dialog Box lets you control the distance between "splats" in
your dotted lines, using either a relative or an absolute measure. If you
specify Absolute (by clicking that button), the number in the Number
box refers to the number of pixels between the center of each splat. If
you specify Relative, then the number refers to the total number of
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Spacing

(Cancel]

<if> Abso I ute

«OK ])

Fill THPe

<if> Solid
o Perspective

~{:::;E~~)r·······_······:::.:
o Gradient lEI ~
o Gradient ® L ;

o i ther: ::1¢.IIU.iii;I lI?:1iiHiii? 11 2

(Cancel)

o Relative

Humber: 1....£3:=.:__

~On

¢ OK ])

Figure 2.5. Spacing Dialog Box

splats in the line. For example, if you specify Relative spacing with
an order of 10, your line (curved or straight) will consist of 10 splats.
Note that spacing also works with the Unfilled Shape tools, even
though a Command-click on those icons does not bring up the Spacing
Dialog Box. To toggle spacing (dotted lines) on and off, click the On
box in the Spacing Dialog Box. A check appears in the box when
spacing is on.

FILL AND SHAPE TOOLS: Command-elicking the Fill icon or the
Filled or Unfilled Rectangle, Circle, Ellipse, or Polygon brings up the
Fill Type Dialog Box (see Figure 2.6), allowing you to specify the type
of fill to be used by these tools.

Figure 2.6. Fill Type Dialog Box
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Figure 2.7. Examples of Three Types of Gradient Fill

The Fill Type Dialog Box is covered in both Tutorials One and Two
and in the Reference section; the following is a summary of its
features:

The example below shows the results of selecting a range of three
colors (black, dark grey, and light grey) and creating three circles, one
filled with each type of gradient. (Dither here is turned off.)

••:.:...•"'.: &

'. 0"

Your fill looks like:If you select:

o Gradientm

o Gradient®

o Gradient [E]

Fill Type defaults to Solid, which is a solid-color fill of either the
foreground or background color. Clicking the mouse button inside a
closed shape fills it with the foreground color, Command-clicking
inside a shape fills with the background color. Click Get Brush to
create a recurring pattern from your current brush and display it in the
Fill Type Dialog Box. Then click Pattern to use that pattern as your
current fill.

You can also choose to fill a shape with a gradient made up of a range
of colors - for example, if Range 1 contains three colors (black, dark
grey, and light grey), the corresponding gradient fill will contain
"stripes" of these same three colors. First, select a color in a cycle
range (see Tutorial One for details on creating color ranges and using
them in gradient fills). To fill a shape with a gradient going from top
to bottom, click the top Gradient button (with the arrows pointing up
and down); to fill with a gradient moving left to right, click the
second Gradient button (with the arrows pointing left and right).
Click the bottom Gradient button (with the rounded corners and the
arrows pointing left and right) to create a left-ta-right gradient fill
with a three-dimensional effect. Here, DeluxePaint fills each
horizontal line independently, thereby allowing the gradient to fill
the contours of the shape being filled. (Note: If your current color is
outside all ranges, DeluxePaint will not create a gradient fill but will
fill with the solid color.)
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Whichever kind of gradient fill you choose, you can adjust its dither,
the amount of random overlap between each shade, by dragging the
Dither scroll box left or right. You can look at the current dither
setting in the box below the scroll box. When you are done, click OK to
use the current settings, or Cancel to return to your work without
making any change.

BRUSH SELECTOR: Command-clicking the Brush Selector restores
the last custom brush. Thus, if you create a custom brush (see Part 1 of
this chapter for details) and then make some modifications, Command
clicking the Brush Selector restores you to the previous custom brush.
This feature is also useful if you create a custom brush and then select a
built-in brush. Command-clicking the Brush Selector returns you to
the custom brush.

GRID AND SYMMETRY TOOLS: Command-clicking these icons lets
you modify aspects of gridding and symmetry. See Part 2 of this
chapter for a detailed description of these features. To turn off these
tools, click the icon again.

If) THE PAINTING MODES

Certain options in the Mode menu - Smear, Shade, Blend and Smooth
- let you make subtle modifications to paint that has already been
laid down. (The others - Matte, Color, Replace, Cycle, and Multi
Cycle - affect the way paint is laid down in the first place by
affecting the current brush. See the Reference section for more
information).

Smear and Smooth modify your painting after looking at the colors
under the brush (ignoring cycle ranges). Smear is the simplest function
- it works just like dragging a brush over a wet oil painting. In other
words, Smear works with the colors under the brush, smearing them in
the direction you move the brush. Use Smear to create the top of a
wave as it's about to break, or foliage on a tree or bush.

Smooth reduces the contrast between two adjoining areas of your
painting (for example, a black area and a white area). Smooth looks
at the colors under the brush, scans the entire palette for colors that
are the "color average" of the colors under the brush (for example,
greys), and then lays down these colors. Smooth works best when the
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palette contains subtle gradations of the colors under the brush (for
instance, various shades of grey) since it has a greater variety of colors
to choose from. Use Smooth to smooth out the boundary between two
contrasting colors and to obtain effects similar to those obtained with
a traditional airbrush or with Antialiasing (one of the Perspective
options available through Options on the Brush menu).

Blend and Shade look at the colors under your brush, the current
foreground color, and cycle ranges. (See discussion on the Palette,
above). With Blend and Shade, you usually work with colors on the
screen that are in the same cycle range and you have your current
foreground color set to a color within that range. Blend is similar to
Smear except that it uses multiple colors from the current color range.
If the current foreground color is in the same cycle range as the colors
under the brush, Blend smears the colors under the brush (in the
direction you move the brush) by adding intermediate colors from the
same range. For example, if your range includes Colors 7 to 9, Blend
lays down dots of Color 8 as you drag the brush over Colors 7 and 9. If
the current foreground color is in a different color range from the colors
under the brush, Blend will have no effect on the colors on the page. If
the current foreground color does not fall within any color range,
DeluxePaint treats the entire palette as a cycle range.

If your current foreground color is in the same range as the color under
the brush, Shade paints with the next-higher or next-lower color in
the cycle range. (If you press the mouse button, you paint with the next
higher color; if you press the Command key and the mouse button, you
paint with the next-lower color.) If the current foreground color is not
in a cycle range, Shade treats the entire palette as the range and lays
down either the next-higher or next-lower palette color. Use Shade to
derive shading effects by adding the next higher (or lower) color in
the range to the color on the page.

The painting modes are described in greater detail in the Reference
section. See the section covering the Mode menu for more information.

DeluxePaint's text feature lets you place text anywhere on the page,
and the Brush Selector lets you pick it up and reposition it if you
didn't have it quite right the first time. You can use any no; font
with DeluxePaint - provided you have installed it onto your
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DeluxePaint program disk. (See your lIes documentation for
instructions on how to move fonts from one disk to another.)

From the Font menu, select the font and style you want (such as the
Chicago 12 point font in the Bold style). To enter text on the screen,
click the Text icon (A) in the Toolbox. When you move the pointer
over to the painting area, it becomes a small vertical line. Click the
mouse button where you want the text to begin, and start typing. The
text will "wrap" around to the next line when it reaches the end of the
line, or you can press Return to start a new line directly below the point
where you first placed the cursor. If the page size is larger than the
screen, the screen will scroll to the edge of the page as you type. You
can delete text on the current line by using the Delete key to backup
and erase the previous character you typed. Note, however, that you
cannot delete text with the Delete key if 1) the screen scrolls as you
are typing or 2) you click the cursor elsewhere on the screen or select a
tool from the Toolbox. Then your text becomes a bit-mapped image,
and no longer behaves as text.

To exit Text mode, select another drawing tool.

To cut and paste text, click the Brush Selector, and holding down the
Command key and the mouse button, pick up the misplaced text. This
lifts the text right off the page, letting you reposition it anywhere you
want.

In the next chapter you will learn a number of practical techniques,
through a series of tutorials, to help you get the most out of
DeluxePaint. The tutorials are simple, step-by-step exercises,
designed with the assistance of professional DeluxePaint artists. You
won't know how powerful DeluxePaint can be until you try it for
yourself.
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The best way to learn DeluxePaint is by doing. Manuals that teach
hnw to drive a car or fly a plane can go only so far - at some point the
student has to sit in the driver's seat and work the controls. So far we
have just been sitting in the garage, examining all the instruments.
Now it's time to start the engine and take the machine out for a spin.
As you've probably guessed, this chapter is the "Driver Ed" part of
the DeluxePaint manual, the place where you can really start creating
impressive graphics.

Tutorial One shows you how to create a custom color palette. Tutorial
Two deals with the creation of a business logo, starting with some
relatively plain text and finishing with graphics impressive enough
to go into an annual report. Tutorial Three takes you through the
world of stencils and friskets, and shows you how you can use
traditional airbrush techniques with a new medium. Finally, Tutorial
Four introduces you to DeluxePaint's perspective capabilities, a way of
simulating three-dimensional space on a two-dimensional screen.

Before we begin, let's make sure that you have everything you will
need for our journey. First, you'll need your DeluxePaint program disk
and art disk. The special files and artwork you'll be using in the
following tutorials are stored on the program disk in the Brush or
Med.Res folders, as appropriate. Second, you'll need a supply of
initialized disks for storing your work. Third, if you want to make
printouts of your work, you'll need a printer plugged in and ready to go.
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o TUTORIAL ONE: MODIFYING THE COLOR PALETTE

Proficiency in modifying DeluxePaint's color palette is one of the most
important skills you can learn. Because every work of art is little more
than the colors and shapes that comprise it, a carefully chosen palette
is the first step to any masterpiece. In the following exercises, you
will learn how to create your own color palette and gradient fill and
how to do color cycling. (See the Reference section for a table of
keyboard equivalents to use in the Palette Window.)

CREATING YOUR OWN PALETTE

The lIGS can generate 4096 distinguishable colors, 16 of which are
available at anyone time in Medium Resolution. You can create your
own 16-eolor palette by modifying the colors on the existing palette.
Here's how:

(~ From the Color menu, select Default Palette. (To do this, move the
cursor up to the Menu Bar. Hold the mouse button down as you move
the cursor down to Default Palette. When you have Default Palette
highlighted, release the button.) Then bring up the Palette
Window by selecting Palette from the Color menu.

(You can also get to the Palette Window by Command-clicking the
Color Indicator (above the main Palette at the bottom right of the
screen), or by pressing p on the keyboard. As you become more
proficient with DeluxePaint, you will realize that most of
DeluxePaint's features are accessible through the keyboard. You can
speed up your work considerably by using the keyboard equivalents.
See the Reference section for tables of keyboard equivalents.)

Take a moment to examine the Palette Window (refer to Figure 2.4). It
consists of six vertical scroll bars for mixing colors, the mixing palette
(where a black-bordered box called the Color Selector marks the
currently selected color), and a collection of command boxes. To find
out more about these functions, refer to the section on the Palette
Window in Chapter Two. For this exercise, you'll be using the Palette
Window to create your own custom palette.
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C" Click on the black in the mixing palette (the topmost color, called
Color 1). Note that the R (Red), G (Green), and B (Blue) scroll boxes
are all at the bottom.

Set Color 1 to pure red by dragging the R scroll box all the way to the
top. (Drag the scroll box by positioning the pointer over it and
pressing and holding down the mouse button as you move the mouse.
Release the button when the scroll box is just where you want it.)
Leave the G and Bscroll boxes at the bottom.

Note that as you drag a scroll box up or down its track, the currently
selected color in the mixing palette changes color accordingly. In
addition, a color change also occurs immediately in the main Palette
below the Toolbox. Also note that, since Color 1 is used for drawing
all dialog boxes and the Toolbox, when you change Color 1 to red,
the Palette Window and Toolbox turn red also.

C" Now copy this red onto the next four colors: Click Color 1, click
Copy, and then click Color 2. Repeat this for Colors 3, 4, and 5 
creating a total of five red squares.

So far you have created a basic set of reds that you'll be adjusting a
little later to make a spectrum. Before you do that, however, let's set
up the rest of the palette in the same way:

C" Make Colors 6 through 10 green: Slide the R a~d B scroll boxes all
the way to the bottom and the G scroll box to the top.

Make Colors 11 through 15 blue by moving the B scroll box to the top
and the R and G scroll boxes to the bottom.

Leave Color 16 as is (white).

Your palette now has five squares each of red, green, and blue, and one
white. Next we'll manipulate the saturation levels and color values
to create variations within each color. Note that you can also create
various shades of a color by creating each color individually, instead
of using the Copy function and then making adjustments As you gain
proficiency, you will find that DeluxePaint lets you achieve the same
results in various ways, giving you the option of choosing the method
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best suited to your working style. You can use either method as you
work through this exercise.

As we noted in Chapter Two, the RGB and the HSV scroll bars are two
different ways of looking at the same thing, and modifying the
settings in one group of scroll bars results in modified settings in the
other group. As you adjust the HSV settings in the following section,
keep an eye on the RGB scroll bars to get an idea of the relationship
between the two sets of variables.

As we explained previously, Saturation refers to the amount of white
a color contains (the higher the saturation, the less white); Value
refers to the amount of black a color contains (the higher the value,
the less black).

(~Select Color I, the first red, and move the V (Value) scroll box so
that it is two-thirds of the way down the scroll bar. Color 1 will
now be a dark red. To check the numerical RGBHSV settings for
this color, press n. This displays the Color Settings Dialog Box.
Your settings should be something like this: Red - 5, Green - 0, Blue-

0, Hue - 0, Saturation - 255, and Value - 91. This numerical
information is useful to know if you want to duplicate the same
shade on a later palette.

For Color 2, the second red, move the V scroll box so that it is one
third of the way down, and leave the Hand S settings as they are.
Leave Color 3 (the third red) as is. For Color 4, move the S
(Saturation) scroll box halfway down. Finally, for the last red
(Color 5), move the S scroll box two-thirds of the way down.

Repeat this same sequence of settings for the greens and blues, then
freeze the palette by clicking OK. The Palette Window will
disappear from the screen. If you have anything showing on your
page, choose Color 16 (white) for your background color, and clear the
screen.

Next, just to practice using your new palette, create a color chart on the
screen. The finished results should look like this:
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3.5

Note: To move to the next color in the Palette, you can use the mouse
or press the] key (to move down) or the [key (to move up).

BGR
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Figure 3.1. Your Color Chart

Now select Color from the Mode menu to tell DeluxePaint that you
want to select brush colors from the main Palette (below the
Toolbox), and then click Color 2 in the Palette. Note that your brush
changes to Color 2 immediately. Place your second square just below
the first. Then place squares of the remaining three reds below
these two.

You now have a column of reds, ranging from a low-value dark red
(almost black) to a low-saturation pale red.

(~ Choose Color 1 for your foreground color. Select the Filled Rectangle
tool and draw a square about the size of a postage stamp. Click the
Brush Selector with the mouse button, and pick up the newly
created square using the Command key and the mouse button. Move
your brush about one inch below "e" in the word Mode (in the Menu
Bar) and click to place a square there.

(~ Now create a column of greens: place a square of Color 6, the darkest
green, to the right of the first red square (leave about 1/4 inch of
space between the columns). Arrange the remaining greens, from
darkest to lightest, in a column under the first green. (Note that the
first three greens - Colors 6, 7, and 8 - are at the bottom of the



Next, let's label the color chart:
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BGR

LOW VALUE
MEDIUM VALUE
PURE COLOR
MEDIUM SATURATION
LOW SATURATION

If a letter doesn't line up exactly, just lift it up with the Brush
Selector (using the Command key and the mouse button) and
reposition it.

If you are using a color printer, you can print out a copy of your
palette.

On the left side of the chart, label the color rows from top to bottom
as follows:

first column in the Palette. The next two greens - Colors 9 and 10 
are at the top of the second column.) To the right of the green
column, create a column of blues using the same technique.

As you have probably realized by now, DeluxePaint has many
advantages over most standard media. Variable magnification,
instant "undoing," and tne vast power of DeluxePaint's brushes have
no counterpart in the world of paper, paint, and ink. For example,
where once a smooth, gradual fade from one color to another required
laborious work with an airbrush, DeluxePaint's Gradient Fill does it
all in seconds. Some of these more advanced features, however,

(~ Select the Text tool by clicking the Text icon (A) to the right of the
Brush Selector. Select Color 1 as your foreground color. To start
typing text, move the cursor above the first column and click the
mouse button. Then use the keyboard to type the column labels
(from left to right) as follows:

CREATING COLOR SPREADS'AND RANGES
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require that you set up your color palette in a certain way to achieve
maximum effect. This exercise will teach you how to get the most out
of the Spread and Range commands to arrange your palette. In
addition, you will create a new palette for the following exercise,
"Animation with Color Cycling."

First, clear the screen, and then select Default Palette from the Color
menu. Select Info Bar from the Edit menu (to give you feedback as you
work with colors). Then bring up the Palette Window by Command
clicking the Color Indicator. Now make the following modifications
to the palette:

<.- Click the first color at the top and make sure it is pure black, either
by moving the V scroll box to the bottom, or by moving each of the R,
G, and B scroll boxes to the bottom. Next, with the first color still
selected, click Copy and then click Color 3.

You have just copied Color 1 onto Color 3. This means that both of
these are black. Next we'll make Colors 3 through 5 black by using
Spread:

<.- Click Color 3, click Copy, and then click Color 5 to make Color 5
black. With Color 3 selected, click Spread and click Color 5.

You have just turned Colors 3 through 5 black. Note that you cannot
change Color 16 (which is currently white) to black. This is to prevent
you from losing your Palette Window, since DeluxePaint uses Colors 1
and 16 for painting the dialog boxes and the Toolbox.

<.- Select Color 2 and make it pure white by moving all three R, G, and
B scroll boxes to the top. To create a 4-tone spectrum that starts
with white at the top (Color 2) and ranges through grey to black
(Color 5), click Spread and then click Color 5 (the last black).

Now we'll create a color spread between red and blue.

<.- Select Color 6 and set it to pure red by moving the R scroll box to the
top, and the G and B scroll boxes to the bottom. Next, make Color 11
blue (maximum B, zero R and G).

The pure red and blue colors define the range of hues that will be
included in your color spread. Now let's fill in the intermediate
colors:

3.7
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(~ Click Color 6 (red), click Spread, and then click Color 11 (blue).

The four colors between pure red and pure blue are now a range of
magentas and violets.

Now you have a spread of colors for your palette, as well as a selection
of greys. Next we'll see how to get more subtle tints and shadings of
one color (blue):

(~Set Color 12 to pure black. At Color 14, create pure blue (B scroll box
all the way to the top, Rand G all the way to the bottom). Select
Color 12 (black), click Spread, and then select Color 14 (blue).
Finally, make sure Color 16 is white and create a spread from Color
14 to Color 16 to give you a set of blues varying in saturation and
value.

You can use this same technique to create tonal ranges for different
colors. Try creating sample tonal ranges for reds and greens.

We've just seen how to set up our color palette using the Spread
command. However, to use Gradient Fill and Color Cycling (as well as
Shade and Blend, see The Painting Modes, in Chapter Two), you have
to define color ranges, to let DeluxePaint know which set of colors to
use. You can define up to four ranges within a palette. Here's how:

(~ After the word Range, click the radio button labeled 1 to define the
first color range.

Note that there is a Range bracket to the right of the mixing palette.
This tells you which colors are within that range.

(~ Point to the top of the Range bracket and drag it to the top of Color 2
(white) by holding down the mouse button as you move the pointer.
In the same way, drag the bottom of the Range bracket to the bottom
of Color 5 (black). The bracket now identifies your newly-defined
color range.

Now click the Range 2 button, move the bottom end of the bracket to
Color 11 (pure blue) and the top end of the bracket to Color 6 (pure
red). Click the Range 3 button and move the ends of the bracket to
Color 16 and Color 12.

3.8 ==!
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You have now defined three color ranges:

1: Four shades from Color 2 to Color5 (greys)
2: Six shades from Color 6 to Color 11 (red-to-blue spread)
3: Five shades from Color 12 to Color 16 (blues)

As you click the Range 1, 2, or 3 button, the bracket identifies the
colors in that range.

Now that you've defined a set of ranges, let's try an experiment with
DeIuxePaint's Gradient Fill feature. Gradient Fill lets you fill any
outline with a range of colors that gradually fade from one to the next
(see Figure 2.7). Here's how:

(..Click OK to leave the Palette Window. Select any color in the first
range (Colors 2 through 5) as your foreground color. Now bring up
the Fill Type Dialog Box (refer to Figure 2.6) by Command-clicking
the Fill tool. To get Vertical Fill, click the first Gradient radio
button (the one followed by the box with the vertical arrows). Then
move the Dither scroll box all the way to the left, and click OK to
return to the painting area. (Dither is the amount of mixing that
occurs between the colors in the range.) Now click the Filled
Rectangle tool (click the bottom right part of the icon).

Note that as soon as you click a color in one of your three ranges, the
small rectangle in the Info Bar gives you a preview of the gradient
fill. (If the Info Bar is not displayed, press 9 on the main keyboard.)
Try clicking colors within the different ranges and watch it change.
As soon as you are ready to move on, click one of the colors in the first
range.

(.. First, set the screen background color to light blue (for contrast) by
Command-clicking Color 15 and then clicking CLR. Draw a filled
rectangle using the mouse button. Note that the shape gradually
fiIls with a banded, metallic shading effect. Bring up the FiIl Type
Dialog Box again and drag the Dither scroll box about a quarter of
the way to the right. Click OK and then draw a second rectangle.
This time you'll see increased dithering: the shades of grey blend
from one to the other, without clear lines between them.

Now that you have the basics down, try experimenting with different
settings. Bring up the Fill Type Dialog Box again and set it to
Horizontal FiIl by clicking the middle of the three Gradient buttons.
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Draw a filled circle with this kind of gradient fill. Now try
Horizontal Line Fill (the bottom Gradient button), and draw another
filled circle. Horizontal Line Fill calculates the distance between the
left and right borders of a figure and fills each horizontal line
independently, so that each line receives the full complement of the
gradient fill. (Note that this circle appears more three-dimensional
than the previous one.)

Select Color 6 (in range 2) and try drawing diamond shapes with the
Filled Polygon tool using both types of horizontal fill, and see the
difference.

Select Color 12 (in Range 3) and draw a filled ellipse. Display the
Palette Window and reverse the order of the gradient fill by clicking
the other cycling direction arrow to the right of the Speed scroll bar
(refer to Figure 2.4). Now create another filled ellipse.

(Note: To cancel the Gradient Fill feature, display the Fill Type
Dialog Box and click the Solid button. Your filled shapes will now be
a solid color - the current foreground color you've selected on your
Palette.)

ANIMATION WITH COLOR CYCLING

Most animation effects are created by displaying a series of drawings
in rapid sequence. DeluxePaint's animation with color cycling uses a
slightly different technique: the illusion of motion is created not by
changing images, but by rapidly changing the colors within a static
image.

Clear the screen. Using Load Picture in the File menu, load the file
Animations (in the Med.Res folder).

(.. Press 9 to hide the Info Bar and 0 to hide the Menu Bar and
Toolbox/Palette. (You can bring them back later by pressing the
same keys a second time). Activate color cycling by selecting Cycle
from the Color menu, or by pressing the Tab key. Pressing Tab a
second time stops the animation. Here's how each animation works:

3.10
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1. THE COLOR WHEEL: The wheel was drawn with lines
radiating out from the center. Each line's color is one shade away
from the lines next to it. As the colors cycle, the wheel appears to
spin.

2. FALLING SNOW: This was done in the same way as 3 below.

3. THE BOUNCING BALL: Each position of the ball was drawn in
a different color from Range 2. Because five of the six colors in this
range are black, only one frame shows at a time, as the remaining
five are invisible against the black background. Change the black
colors in this range to any non-black color to see all the frames.

4. MARQUEE: This effect was created with the 2 colors from
Range 4. In fact, the "lightbulbs" are only flashing on and off. The
viewer imagines the motion, just as he does with a real movie
marquee. (Change Color 16 from black to another color to see all the
frames.)

5. THE RUNNING MAN: This was done in exactly the same way
as the Bouncing Ball. Notice how the frames overlap slightly.

Bring up the Palette Window, and play with the animation speed of
the Color Wheel by clicking the Range 3 button, and then moving the
Speed scroll box. (To the left is slower, and to the right is faster. If
the scroll box is all the way to the left, cycling is turned off.) You can
change the direction of the cycling by clicking the other arrow to the
right of the Speed scroll bar.
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f) TUTORIAL TWO: LOGOS UNLIMITED

In this series of tutorials, we will take a relatively plain corporate
logo and spice it up with some of DeluxePaint's tools. We have
provided the original logo for you so you won't need to start from
scratch. All you need to do is embellish it by following the step-by
step instructions. First, however, you will need to load the original
logo, which has been saved as a brush in the Brush folder of your
DeluxePaint art disk. From the File menu, select Load Brush; select
the folder Brush, and click Open. Then select the file Archbrush, and
click Open again. When the brush has finished loading, select Use
Brush Palette from the Color menu to use the same palette the brush
was created with. Finally, Command-click Color 1 (black) and then
CLR to change the background color to black.

Let's see how easy it is to spice up the standard logo:

ITALICIZE

Let's begin by italicizing the logo. DeluxePaint lets you tilt any
image, whether text or graphics, just by making a menu selection.
Here's how:

C"-From the Brush menu, select Shear. Move the brush onto the screen,
and, while holding the mouse button down, move the mouse
horizontally across the screen. When you are satisfied with the
slope of the letters, release the button.

As you can see, Shear anchors the top part of any image, thereby
allowing you to stretch the bottom part horizontally in either
direction. If you are doing this with text (as we did above), you can
italicize letters to any angle you wish. Click the mouse button to place
a copy of this new brush on the screen. If you want to save the new
brush (remember, it's a brush, not just an image on the screen), select
Save Brush from the File menu, specify the folder and filename (make
sure you don't give it the same name as the original), and then dick
Save. To save onto your second drive, first dick Disk.
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This time, we'll bend the logo vertically. Although you are free to
compound these effects (that is, you can bend an image that has
already been italicized), let's .start with the original brush again so
we can see what effect bending has by itself. To restore the original
brush, Command,lick the Brush Selector icon in the Toolbox. This
restores the brush to its immediately preceding state. (If you modify a
brush more than once, you cannot restore it to its original state using
this technique - you would need to load the brush again.) Now bend
the brush as follows:

C'" From the Brush menu, select Bend Vertical. Move the brush to the
center of the screen and, while holding the mouse button down, drag
up or down to "bend" the brush. When you release the button, you
will see that the brush now has a new shape. Click the mouse
button to place an image of the new brush on the screen.

If you like, you can save the new brush on disk. Just follow the
instructions outlined in the Italicize section above.

In this exercise we'll resize the brush, stretching or shrinking it to a
different size. Restore (or reload) the original brush and then follow
these steps:

C'" From the Brush menu, select Stretch. As you move the brush back
onto the screen, you will notice that your cursor has changed to a box
with a smaller box inside. While holding down the mouse button,
drag the mouse diagonally. Drag it down and to the right to stretch
it, and up and to the left shrink it. When you are satisfied with the
new size, release the button.

Note that if you want to resize the brush in proportion to the original
- that is, keeping the original ratio of height to width - press the
Shift key before you start dragging the mouse, and hold it down as you
drag. By constraining the change in this way, you can resize the image
in direct proportion to the original. Also note that if you try to make a
brush larger than the available memory can handle, the brush will
snap back to its starting size and shape.
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CHANGING COLORS

In this exercise, we will change the colors of the original brush - red
and grey on a black background - to a new set of colors. After
reloading the brush, click with the mouse button to place an image of
the brush on the page. Here's how to change the brush's colors:

(~Click a medium blue shade from the Palette. This is your new
foreground color, soon to be the new brush color.

Next, select the red of the original brush as the background color.
You can do this using either of two techniques. First, you can select
the red by Command-elicking the mouse button on that color in the
Palette. (Make sure you select the correct red.) Alternatively, you
can click inside the Color Indicator (your cursor changes into the
Color Selector cursor). Now when you Command-elick on a screen
color (for example, red), that color will become the new background
color.

Because it can convert your entire painting area into a palette, this
technique of clicking the Color Indicator to select any screen color as
the new foreground or background color is particularly useful.
Whatever color you click in the painting area with the Color Selector
cursor becomes the foreground color, and whatever color you Command
click becomes the background color. (You may find the keyboard
equivalent even more useful: press the comma key to get the Color
Selector cursor, and then click on any of the screen colors as described
above.)

Make sure that your new foreground color is medium blue and the
background color is red. The next step is to switch the foreground and
background colors, so that every pixel of the current background color
(red) in the brush will change to the current foreground color (blue):

(~ From the Color menu, select Back -> Fore Brush.

Notice that selecting Back -> Fore Brush changed the red parts of the
brush to blue. If you had an original brush that contained both red and
blue, you could make the changes work in both directions by selecting
Back <-> Fore Brush and then changing the background color to
something other than red (to make the red visible instead of
transparent). This would change all the red parts of the brush to blue,
and all the blue parts of the brush to red.

Now that you've seen how easy it is to change colors, you might want
to try changing colors on all the brushes you'll be creating in this
tutorial.
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Reload the original brush by selecting Load Brush from the File menu.
When the brush has loaded, place an image of it on the screen by
clicking with the mouse button.

In this exercise, you'll be coloring the brush image with a pattern
rather than a solid color. Here's how:

(... Load Pattern! from the Brush folder and select Use Brush Palette in
the Color menu. Your new brush will be a small square with
horizontal blue stripes. Now Command-click the Fill tool icon to
bring up the Fill Type Dialog Box. Click Get Brush. This last action
places a copy of the current brush pattern (the one we just loaded) in
the dialog box. Click Pattern to set this pattern as the current fill;
then click OK.

The next step is to use this pattern fill to spice up our logo:

(... Click the Fill tool icon, place the dripping paint portion of the
cursor on the grey parts of the arch graphic, and click until the arch
is completely filled with the pattern (two applications should do
it).

You might want to do the same thing with the lettering, but this time
try creating your own pattern. Using the Straight Line tool and the
second round brush from the left, draw a series of horizontal deep-blue
lines, equally spaced from each other (about one pixel apart should
work fine). Now click the Brush Selector and pick up some of the
pattern as a brush. Make sure you pick up a representative part of the
brush, one that will give you a recurring pattern. Command·dick the
Fill tool icon to bring up the Fill Type Dialog Box, and select Get
Brush as before. If the pattern in the box does not look right (e.g., if it
has an extra white line somewhere), go back to the pattern on the
screen and pick it up again, this time making sure you don't pick up too
much or too little. When you are satisfied, go back to the Fill Type
Dialog Box and click Get Brush and Pattern and then OK to complete
the transaction. Now when you use the Fill tool icon, the paintcan
will be filled with the pattern you created. As you click on each letter
of the name, it will fill with the new pattern.
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In this exercise we will give our logo a professional touch by adding a
drop shadow. A drop shadow creates an illusion of depth by putting a
dark shadow under an object. First, load your standard Archbrush, and
then click the color you want to use for the shadow (making it the
foreground color). Black and brown are the most appropriate shadow
colors. Then do the following:

C" Select Color from the Mode menu (or press the 2 key, the keyboard
equivalent).

The Color option turns a multicolored brush into a solid color, the
currently selected foreground color. This is a way of selecting brush
color from the Palette, just as we did when we created your custom
palette in Tutorial One. When you are in Color mode, DeluxePaint
uses just the outline of the brush, and colors it the current foreground
color.

C" Position the new (solid-colored) brush on the screen and click to
place an image of it there.

You have just placed a copy of the logo's shadow on the screen. Now
you need to revert to the standard brush so you can place a copy of the
logo over the shadow.

C" Select Matte from the Mode menu to restore the brush to its original
form (or press 1) and position it over the shadow. Offset the
standard brush slightly so you can see the shadow underneath it and
press the mouse button.

You have just created a logo with a drop shadow to create the illusion
of the logo hovering slightly above the page. You might want to save
it as part of your library of Arch logos. Remember to give it a different
name before you save it; otherwise you will lose the original brush.
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OUTLINING THE LOGO

In this exercise, we will put a different-colored outline around the
logo. As before, begin by reloading the standard Archbrush and then
select as your foreground color the color you want to use for the outline.
Choose a color that is not already represented in the logo, as this will
make it easier to change it later without affecting the rest of the logo.

C'- Select Color from the Mode menu (or press 2).

As before, this turns your multicolored brush into a solid color, the one
you chose as your foreground color.

C'- Select either the Unfilled Rectangle tool (for a squared-off outline)
or the Unfilled Circle (for a rounded outline). Move the crosshair
back to the screen and, holding the mouse button down, drag down
diagonally a few pixels. Each pixel you drag the mouse increases
the thickness of the outline by that amount. Release the button.

As you have probably noted, the Rectangle and Circle drawing tools
paint with the current brush, whether it is a built-in or a custom brush.
This lets you create an accurate outline of any shape, just by dragging
it the required distance.

C.- To revert to the original multicolored brush, select Matte from the
Mode menu (or press 1), or Command-elick the Brush Selector.

Position the original brush over the outline and click the mouse
button to deposit an image there. You can now pick up your new logo
as a brush, and then repeat the same procedure to produce multiple
outlines.

GRADIENT FILL

One of DeluxePaint's most powerful features is its ability to fill a
shape with multicolored gradients as well as with solid colors. In
this exercise, we'll see how easy it is to create a gradient pattern and
fill the arch in our logo with it. As before, clear the screen, restore or
reload the standard Archbrush, and place a copy of it on the screen by
clicking the mouse button. First we'll define our gradient range:

C.- Bring up the Palette Window by Command-clicking on the Color
Indicator, or by pressing p from the keyboard. From the Palette
Window, create the color range you wish to use for your gradient
fill. (For creating a color range, see Tutorial One). When you've
defined your ranges, click OK to return to the painting screen.
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We have now created a color range to use as a gradient fill. Now when
you fill a shape with a gradient fill, it will use that color range.
First, however, you need to select one of the colors in the range by
clicking it with the mouse button. Next, you need to tell DeluxePaint
to use that color range as a fill pattern. Here's how:

(~ Command-dick the Fill tool icon.

This tells DeluxePaint that you want to customize the icon's effect,
and brings up the Fill Type Dialog Box. Remember, Command-elicking
the drawing tools lets you customize the respective effects; see The
Tools, in Chapter Two, above. Now you need to select the variables
you want to use for your gradient fill:

(~Click the top Gradient radio button (for Vertical Fill), and then
drag the Dither scroll box left or right to create the desired amount
of dithering in the gradient. Click OK to complete the transaction.
When you return to the painting area, click the Fill tool with the
mouse button to select it, and then click on the arch symbol to fill it
with the gradient.

Try experimenting with different gradients and dithering to get an
idea of the variety of effects available to you. Try the different
gradient fills and see how they work on the Arch logo.

You have just seen how to take a relatively plain logo and embellish
it with some of DeluxePaint's tools. In the next tutorial, we will
explore the uses of stencils and friskets.
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mTUTORIAL THREE: THE WORLD OF STENCILS

In the following set of exercises, you will learn how to create and use
stencils within DeluxePaint. Although stencils are primarily used
for producing quick, uniform lettering by amateur signwriters, they
have uses that go far beyond that. Airbrush' artists, for example,
use stencils (called friskets) to cover certain areas of their work
while they airbrush other areas. In fact, for an airbrush artist the
creation of friskets is probably the Single most important part of a
job, because the final image can be only as good as the friskets that
define the boundaries between its various areas.

DeluxePaint makes it easy to create a stencil for any part of an
image, without the need to redraw the image. All you need to do is
specify the colors that make up the stencil, and DeluxePaint does
the rest, even if the image is highly intricate. By contrast, an
airbrush artist has to create his image twice - once when he draws
the original design, and again when he cuts out the friskets.

Here's how it works: when you make a stencil for a particular set of
colors, you are locking (and thus protecting) any parts of the picture
that are made up of those colors, making them impervious to any
overspray. This means that when you have a stencil for a
particular set of colors, you cannot paint over those colors until you
turn the stencil off. It also means that you can essentially paint a
picture backwards, from the foreground to the background, because
you can use stencils to mask any foreground objects from the colors you
are using for the background objects.

The follOWing exercises explore various aspects of stencils in
DeluxePaint. Before you begin, go to the File menu and load the
picture called Stencilset from the Med.Res folder on the
DeluxePaint art disk.
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DISTANT SNOWCAPS

The left part of the Stencilset picture shows a distant mountain range
behind a green field and under a colorful sky. (If you followed the
preceding tutorial, you'll realize that both the sky and the field were
createct with a Gradient Fill, in a fraction of the time it would take
using more traditional techniques. See the Gradient Fill exercise
above.) Note that the mountain range is actually made up of several
ranges, with the more distant ones painted in lighter shades than the
nearer ones. In this exercise, we will put a snowcap on the most distant
range without disturbing any other parts of the picture. This would be
a tall order for any other graphic medium, but is surprisingly easy
with DeluxePaint. For example, if you were to do this using a
standard airbrush, you would need to cut out friskets to cover every
part of the image except the distant mountain range, and then spray
the picture, all the while hoping that none of the snow color would
bleed under the friskets.

Let's create a stencil that "locks" every color in the picture except
Color 4, the color of the most distant mountain range. We cannot paint
over locked colors. So, in this case, Color 4 will be the only color we
can paint snow on.

(... From the Pict menu, select Make Stencil to bring up the Make Stencil
Dialog Box (see Figure 3.2). Click Clear, click on Color 4 (the blue of
the most distant mountain range), click Invert, and then click Make.

Hake Stencil

( Clear ) Locked:

( Invert ) • ~.:..~.:::::.::.:
111111111 II

.... .. •« Hake »III II ~ ~
( Cancel ) mmm

.;'/:;'/ e",'//
:~~~~

Figure 3.2. Make Stencil Dialog Box

The first click cleared the picture of any stencils, the second selected
the stencil color, the third click inverted the stencil configuration
(making everything except Color 4 a stencil), and the fourth made the
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stencil. To let you know that you have a stencil active, an "S" appears
on the Info Bar. (If the Info Bar is not showing, select Info Bar from
the Edit menu.)

Note that clicking Invert simply inverts the current stencil
configuration, saving you the trouble of clicking all the colors except
the one you want to paint on. This is useful if you want to paint on one
or two selected colors to the exclusion of the rest; if you want to create
a stencil to lock only one or a few colors, then use the direct approach.
The next step is to paint the snow on the distant mountain range:

C.- Select white as the foreground color by clicking Color 16, and then
select the one-pixel brush and the Airbrush tool. Move the cursor
over to the distant mountain range and spray a snowcap on it.

Because every color except that of the mountain range has been locked,
you can spray without fear of contaminating any adjoining colors.
Note that although the white you are spraying on the mountain range
is one of the locked colors, it is not itself locked while you are
applying it. This means that you can paint over it with another color
(such as the original color of the mountain, if you don't like the look of
the snowcap) just as though it were unlocked. To lock a recently
applied color, select Make Stencil again and click the Make button.

This also means that you can use the "Again" key (a) to bring back the
Make Stencil Dialog Box, if Make Stencil was your last menu
command. (The Again rule is simple: press a whenever you want to
repeat the immediately preceding menu command, to save your moving
the mouse up to the Menu Bar and through menu options. If your last
menu command produced a dialog box, then pressing a will produce
that same dialog box, without the need for menu selections.)

SUNRISE IN THE ROCKIES

In this exercise, we will make the sun rise behind the mountains in the
Stencilset picture. So we need to lock every color except the sky.
Here's how:

C.- Bring up the Make Stencil Dialog Box, click Color 4 (the distant
mountain color) to lock it, and then click Colors 2 and 6 through 9
(the sky colors) to unlock them. Click Make.
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You have now locked every color in the landscape except the sky
colors. Now let's make the sun rise:

(... Make black your current background color. Click the Brush Selector,
move the large crosshair over to the sun image (on the far right of
the screen), and pick it up with the mouse button. Move the brush
over to the sky above the mountain range. (Note: You won't see the
brush until you move it to the sky area.)

Did you see the sun move behind the mountains and then peek
through? This is because every color - except the sky colors and the
background- is locked, and so will not accommodate the sun brush.
When you are satisfied with the placement of the sun, click the mouse
button to stamp an image of it there.

CUTIING SOME l'S

In this exercise, we will explore further aspects of DeIuxePaint's
powerful stencil editor. In particular, you will see how to turn stencil
colors on and off from your screen, not just from the Make Stencil Dialog
Box. (In this exercise, we are still working with the Stencilset
picture.)

(... Bring up the Make Stencil Dialog Box, and click Gear to clear all
the stencils. Select a color other than red, blue, or yellow as your
background color - for example, Color 11, green. (Thus, when you
pick up your brush below, none of its colors will be transparent.)
Now move the pointer outside the dialog box and click the large Z
shape at the bottom of your picture. Click Invert in the dialog box
and then click Make to create a stencil and return to the painting
screen.

Now let's see what we can do with the stencil we just created:

(... Click the Brush Selector and pick up the textured area to the right
of the Z. Move the cursor over to the Z and watch what happens.

Did you see the textured brush appear behind the Z? Because all the
colors except the Z are locked, it looks like you are viewing the
textured brush through a Z-shaped window. Now, when you place the
textured brush behind the Z and click the mouse button, you will fill
the Z with the textured pattern.
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THE EYES HAVE IT

You may have trouble finding a practical application for this next
exercise, but it's fun nonetheless.

(~Open the Make Stencil Dialog Box, click Clear, and then click the
following colors: 3, 6, 15, and 10. Click Make to complete the
transaction. Now pick up the two blue circles at the lower right and
move them over to the face.

Because all the colors in the face are now locked, the two circles
appear to move behind it. When the circles are directly behind the
eyes, you can make the eyes appear to move around just by moving the
cursor around. You can set the eyes in any position you like just by
clicking the mouse button. If you don't like it, click Undo and try again.

FIXING THE BACKGROUND

By using a combination of stencils and fixing the background, you can
define a stencil by area rather than color. This lets you confine a
stencil to a particular area of the page, without forcing you to lock
every instance of a particular color. Let's take a closer look:

(~Cancel the previous stencil by selecting Free Stencil from the Pict
menu (or by pressing the' key to the left of the Spacebar). Make sure
your current background color is black.

Pick up the small clump of pine trees from the right-hand side of
the page (above the blue circles). From the Pict menu, select Fix
Background.

You have just fixed the picture to the background (the B in the Info
Bar tells you so), which means you can always return to that picture by
clicking CLR. Thus, you can stamp pine trees all over the landscape
and then return to the original picture at any time. You can also fix
the background successively, updating the picture from the previous
"fix." (As we saw earlier, you can press a, the Again key, to repeat the
immediately preceding menu option.) For the purpose of this exercise,

3.23



CHAP TER THREE: TUTOR IALS

go ahead and stamp a few clumps of pine trees on the closest mountain
range. Now let's turn that collection of pine trees into a stencil:

C'" From the Pict menu, select Lock For~ound.

This last action turned the foreground (Le., everything you added to
the picture since fixing the background) into a stencil, but without
affecting any other part of the picture that uses those same colors. Try
it and see. Move your pine-tree brush over to the pine forest and you'll
see that your brush goes behind the forest but in front of everything
else. You can remove this stencil either by turning the stencil off
(selecting Toggle Stencil from the Pict menu) or making a different
stencil by locking colors in the Make Stencil Dialog Box. And as is the
case with regular stencils, clicking CLR does not clear the stenciled
area - it is protected until you tum it off, just like the fixed
background.
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D TUTORIAL FOUR: PUTTING THINGS IN PERSPECTIVE

In this tutorial, we will be examining the rotation and manipulation
of brushes about the three spatial axes to produce perspective effects
without the need for technical drafting tools.

In Perspective mode, you work within the three spatial axes - x, y,
and z - to create three-dimensional objects. Visualize that the x and
y axes are on the surface of your screen and the z axis runs
perpendicular to the screen (toward the back of your monitor), as
illustrated in Figure 3. 3 below.

y

Figure 3.3. The Three Axes Used in Perspective Mode

In this manual, the three axes always refer to the orientation of the
brush. When you first enter Perspective mode, the screen's x-, y-, and z
axes correspond to the brush's x-, y-, and z-axes. Once you rotate the
brush, however, the brush and the screen no longer share the same
axes. In Figure 3.4 below, a brush is rotated away from you about its x
axis. The x-axis remains the same, but both the y- and z-axis have
been rotated. Figure 3.4 also shows the brush's original y-axis and its
new y-axis.
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angle of rotation

Brush's new
y-axis

Brush's original
y-axis

Figure 3.4. Example of a Rotated Brush

Perspective mode also lets you place the perspective center (the point
level with the viewer's eye) anywhere on the page. In addition, by
selectively fixing anyone of the three axes, you can make your brush
change size as it moves up and down the page, letting you create objects
that recede into the distance. Here are some exercises showing you
how:

In this exercise, we will learn how to rotate the image of an object (an
area rug) to change its perspective.

(~From the File menu, select Load Brush, and open the Brush folder.
(You might have to close another folder first.) Then load the brush
named Dolphin. Select Use Brush Palette from the Color menu. Set
the background color to white, and click CLR. Select Info Bar from
the Edit menu. Make sure that Coordinates and Brush Handle (in
the Edit menu) are turned off.

AN AREA RUG
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Our first job is to define the perspective center (the viewer's eye
level). For the purposes of this discussion, let's assume that there is a
horizontal plane (the view plane) passing through that point.

C" From the Brush menu, select Perspective or press Enter on the
keypad.

Note that when you do so, your brush turns into a large four-cell
rectangle (called the brush outline). This is how your brush is
represented in Perspective mode. You will also notice a small
crosshair in the center of the page. This is the existing (default)
perspective center.

First, let's change the perspective center:

C" Press the Decimal Point on the keypad. This changes your cursor
into a large crosshair. Move the large crosshair to a point about one
inch below the Menu Bar and about halfway across the page, and
click the mouse button.

This sets a new perspective center until we change it again. The cursor
now changes back into the four-cell brush outline.

As we noted earlier, you can rotate your brush about any of its three
axes, x, y, and z. When you first enter Perspective mode, your brush
and the screen share the same axes; that is, the brush's y-axis
corresponds to the screen's y-axis, and so on. Thus, moving the mouse
backward and forward causes the brush to move up and dawn on the
screen, along its y-axis. (And moving the mouse left and right causes
the brush to move left and right, along its x-axis). When you rotate
the brush (and its axes), mouse movement still translates into
movement along the x- and y-axes, but these axes are now relative to
the brush's orientation, rather than to the screen. For example,
suppose you rotate a brush so that its y-axis is now running
perpendicular to the screen. When you move the mouse backward and
forward again (to move the brush along its y-axis), the brush outline
will now move closer to you and farther away.

If you would like to read more about DeluxePaint's perspective
features, see the discussion under the Brush menu in the Reference
section. However, it's a lot easier to understand how perspective
works by trying a few examples. To illustrate an important rule of
perspective, we will paint a "rug" on the floor using two different
methods.
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Method 1: With this method, we'll rotate the brush first, and then
fine-rune its plane relative to the view plane by using the apostrophe
key. First let's rotate the brush:

(..Move the brush outline so that its center coincides with the
perspective center. Hold down the Shift key and press Keypad 8.
(Or to watch the brush outline rotate one degree at a time, hold
down Keypad 8 until 90 appears at the right of the Info Bar.)

You have just rotated the brush 90 degrees about its x-axis. But because
the center of the brush corresponds to the perspective center, you are
viewing the brush edge on, which explains why it is difficult to see,
Note that the brush's y-axis is now perpendicular to the screen and its
z-axis is now vertical, which means the rug is lying flat. You can
always tell the current state of rotation in degrees (relative to the
screen) from the coordinates at the right of the Info Bar, At the
moment, it shows 90, 0, 0 to indicate that the brush has been rotated 90
degrees on the x-axis, with zero rotation for the y- and z-axes.

(A note about the Shift key: When used in conjunction with the other
keys that affect brush orientation, the Shift key increases the
increments of rotation or movement along an axis. For example, by
using the Shift key when you pressed the Keypad 8 above, you were
able to rotate the brush 90 degrees with a single movement. You could
have achieved the same result by pressing the un-Shifted 8, but you
would have had to do so 90 times (since each keypress rotates the
brush one degree). Note that 90 degrees is the default rotation value
(called the Angle Step) that is linked to the Shift key. You can enter
a new value by Command-elicking the Grid icon while in Perspective
mode.)

Now let's define a new brush plane. Since we want to paint a rug on
the floor, we'll move the brush down its z-axis (the screen's y-axis), so
that the brush is below eye level:

(.. Hold down the Shift key and press the I (apostrophe) key.

You have just shifted the brush down its z-axis, so that it is below eye
level. The apostrophe and the semicolon keys control movement down
and up the brush's z-axis, letting you fine-tune the brush plane after
rotation. Now as you move the mouse forward and backward, the
brush outline moves forward and backward, along the plane we
defined.
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Let's paint the rug on the floor:

(~Move the brush outline so that its base is near the bottom of the
screen, and click the mouse button.

The result is a view of a rug as it might appear from normal eye level.

Method 2: Now let's create the same effect using a more direct
method. In Method 1 above, we rotated the brush at a time when the
brush center coincided with the perspective center. Because the brush
plane and the view pl.ane were identical, we had to take a further
step to adjust the brush plane, by using the apostrophe key. In Method
2, we'll move the brush center below the perspective center and define
a new brush plane first; then we'll rotate the brush.

First let's define the brush plane:

(~ Click CLR to get a fresh page. Press Keypad 0 to reset all three axes
to zero. Position the brush outline so that its center is about one
third of the way down the page.

Now let's rotate the brush:

(~Press Shift Keypad 8 (to rotate the brush 90 degrees around its x
axis). Click the mouse button to paint the brush in its rotated form.

By positioning the brush outline below the perspective center, we set
its x,y plane parallel to but below the view plane, and we did so
without using the apostrophe key. This illustrates the first important
rule of perspective:

The location of the brush outline at the time you rotate the brush
determines the position of the brush plane relative to the view plane.

Whichever method you use, the result is a rug as it might appear from
normal eye level. You can "clean up" the image by selecting Options
from the Brush menu and then Anti-Aliasing Low or High from the
Perspective Options Dialog Box before you place an image of the brush
on the page. Note that with anti-aliasing turned on, it can take
substantially longer to paint a rotated brush.

3.29



CHAP TER THREE: TUTOR I ALS

A RUG ON THE CEILING

In this exercise, we'll rotate the brush to provide us with a view of the
same rug as it would appear if it were mounted on the ceiling. This
time we need to use the opposite procedure:

C" Click CLR to get a fresh page. Press Keypad 0 to set all axes to zero.
Press the Decimal Point key on the keypad and move the large
crosshair to the center of the page and about one inch from the
bottom, and click the mouse button. Move the brush outline so that
its center is about two-thirds of the way up the page, and press
Shift Keypad 7 to rotate the top of the brush 90 degrees towards you
(or hold down Keypad 7 until 270 appears in the Info Bar.) Click
the mouse button to paint the area rug on the ceiling.

We have already seen that Keypad 8 (and Shift Keypad 8 ) control
rotation about the brush's x-axis. The same applies to Keypad 7,
except that it rotates the brush in the opposite direction about its x
axis. Keypad 9 resets the x-axis to zero rotation. This means that all
x-axis rotation is controlled by the tap row of keys on the keypad.

In like fashion, all y-axis rotation is controlled by the middle row of
keys on the keypad, and z-axis rotation by the bottom row. Thus, to
rotate the brush about the y-axis, press the Keypad 4 or 5 keys, and to
reset the y-axis to zero, press the Keypad 6 key. To reset all three
axes to zero, press Keypad O. By now, you have the fundamentals of
perspective at your fingertips, so you should feel free to experiment
with different brush rotations.

CUBISM REVISITED

In this exercise, we'll see how easy it is to create cubes in any
orientation in three-dimensional space. Let's start by creating a new
brush:

C" Clear the screen. Click the Grid icon to turn on the Grid. Command
click the Fill icon and click Solid and then OK (to get a solid fill).
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Select the Filled Rectangle tool and a foreground color that
contrasts with the current background color. With the Shift key
held down (to constrain the rectangle to a square), draw a square
about two inches wide. Select a new foreground color and draw a
second square inside the first.

Now let's pick up the square as a brush and move it into Perspective
mode:

(.,. Click the Brush Selector; then pick up the square using the
Command key and the mouse button. Try not to pick up any
background color when you pick up the square. From the Edit menu,
select Brush Handle to move the arrow cursor to the lower right
corner of the brush. Select Perspective from the Brush menu (or press
Enter on the keypad) to enter Perspective mode.

Our first job in perspective is to reset all axes to zero and to redefine
the perspective center:

(.,. Press Keypad 0 to reset the axes. Then press the Decimal Point on
the keypad and set the perspective center to the center of the page,
about one third of the way down.

When the grid is on in Perspective mode, the size of the grid defaults
to the brush dimensions, Le., the grid's x and y dimensions correspond
to the brush's x and y dimensions. In addition, the grid's z dimension
corresponds to its y dimension. You can change these settings by
Command-clicking the Grid icon while you are in Perspective mode,
but for this exercise we want to use them just as they are, because that
is the best setting for creating cubes.

(.,. Move the brush outline to the bottom left side of the screen and click
the mouse button to place an image there. Note that since the Grid
is on, DeluxePaint lets you place an image only at certain places on
the screen (along Grid lines).

You have just created the front face of the cube. Next, we need to
rotate the brush about its y-axis to create the right face of the cube:

(.,. Press Shift Keypad 4 to rotate the left side of the brush back 90
degrees. Without moving the brush, click the mouse button to place
an image there. Then press Shift Keypad 5 to rotate the brush back
to its original position.
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We have just built two sides of the cube. Now let's put a top on it:

<.. Without moving the brush left or right, slide it up one Grid position
("notch") so it is directly above the first side of your cube. Press
Shift Keypad 8 to rotate it 90 degrees about its x-axis. Click the
mouse button to paint the top on the cube.

You probably noticed that the above construction involved minimal
mouse movement. This is because with Grid turned on and the handle
at the lower right corner of the brush, you only need to move the mouse
two or three times. All rotations are about the brush handle, which
automatically places the sides of the cube in their correct positions.
Now that you have the rudiments down, try stacking cubes on top of
each other, or stacking them side by side. Because you are in three
dimensional space, the possibilities are almost endless.

A ROW OF STATELY HOMES

For this exercise, load the brush called Building and select Use Brush
Palette from the Color menu. Reenter Perspective mode by pressing
Enter on the keypad. We will be rotating the brush about its y-axis to
provide a view of a building from the side. In addition, we'll be
resetting the perspective center to provide a "street-level" view.

<.. Clear the screen. Turn off the Grid, and turn off Brush Handle on the
Edit menu. Press Keypad 0 to reset all three axes to zero, and then
press the Decimal Point key on the keypad to reset the perspective
center. Move the large crosshair to about one inch from the bottom
and about one inch from right-hand edge of the page (near the
Palette) and click the mouse button.

Now we'll rotate the brush about its y-axis:

<.. Position the brush outline so that its center coincides approximately
with the center of the page. Press Shift Keypad 5 to rotate the
brush 90 degrees about the y-axis. Move the brush to the left-hand
side of the page. When you can just see the left-hand edge of the
brush outline (Le., just before it disappears off the left-hand side of
the page), click the mouse button.
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You have just painted the first of a row of buildings. To complete the
row, move your brush so that its left edge coincides with the first
building's right edge and place an image there. Continue this process
until you have completed the whole row. As before, you may want to
clean up the jagged edges a little. You could also "turn off' some of the
lights by painting them a different color. You're the architect. You
can even turn your buildings into highrises if you like. Just add a
second layer on top of the first.

ANOTHER POINT OF VIEW

When we built our row of homes, we placed the perspective center (the
viewer's eye level) toward the bottom right-hand corner of the page.
This resulted in a row of homes as they would appear from street
level. We could have placed the perspective center near the top of
the page and created a row of buildings viewed from a higher plane.
As an exercise for yourself, go back and recreate the row of buildings,
but this time place the perspective center about one inch from the top
of the page rather than the bottom. Press Keypad 0 to reset the axes,
move the brush outline to the center of the page as before, press Shift
Keypad 5 to rotate the brush 90 degrees about the y-axis, and click the
mouse button to paint. This time the buildings will appear to be
viewed from above.

FIXING AXES AND OTHER MYSTERIES

We have already seen how mouse movement translates into movement
along the brush's x- and y-axes, and that this continues to be the case
after the brush is rotated. We have also seen how to position a brush
on its z-axis by controlling the position of the brush when you rotate H,
and by using the apostrophe and semicolon keys to fine-tune that
position after rotation. Now it's time to examine these concepts a
little more closely.

The reason movement along a brush's z-axis is controlled by brush
position at the moment of rotation (and by the apostrophe and
semicolon keys after rotation) is simply that the mouse is only capable

3.33



CHAP TER THREE: TUTOR IALS

of two-dimensional movement. Lifting the mouse off the table (the
third dimension) has no effect onscreen, and so it is necessary to fix one
axis with respect to mouse movement. When you first enter
Perspective mode, the brush's z-axis is fixed, which means that mouse
movement controls movement only along the brush's x- and y-axes.
This, however, is only the default mode; you can selectively fix any
one of the three axes, and allow mouse movement to control the other
two. And as you might expect, brush placement (and the apostrophe
and semicolon keys) controls movement along the fixed axis,
whichever one that might be, just as it did when the z-axis was fixed.
To see how this works in practice, try the following simple exercises:

(~Clear the screen. Place the perspective center at the center of the
page. Reset the brush rotation to zero by pressing Keypad 0, and
move the brush outline so that its center coincides with the
perspective center.

To fix the x-axis, press Shift Keypad 9 (remember, the top row of
the keypad controls the x-axis).

Now when you move the mouse, your brush will move along the y- and
z-axes. Try it and see. If you move the mouse to the right of center, it
gets larger; if you move it left again (back toward the center of the
screen), it gets smaller. This is because side-ta-side movement now
controls movement along the brush's z-axis, the one perpendicular to
the screen. On the other hand, moving the mouse backward and
forward (toward you and away from you) has no effect on brush size,
because this simply moves the brush along its y-axis. As you've
probably guessed by now, this is an easy way to resize a brush: fix the
x-axis, move the brush horizontally until it is the right size, and then
click the button. Similarly, you can rotate a brush simply by rotating
it about its z-axis (the bottom row of the keypad).

Press Keypad 0 to reset the axes and to refix the z-axis. Now try
fixing the y-axis (Shift Keypad 6) and doing the same thing. This
time, backward-and-forward mouse movement controls movement
along the brush's z-axis, while side-to-side movement controls
movement along the x-axis. To fix the z-axis again, press Shift
Keypad 3.
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CITY PLANNING

Let's try our new axis-fixing skills on some city planning, and create an
entire city with a single brush. Here's how:

C'- Reset all axes to zero (Keypad 0) and place the perspective center at
the center of the page and about one inch from the top. Move the
brush outline so that its top coincides with the perspective center
(Le., about one inch from the top). Press Shift Keypad 6 to fix the y
axis.

By fixing the y-axis, backward-and-forward mouse movement now
controls movement along the brush's z-axis. You can now stamp
buildings all over the page, and they will vary in size in accordance
with their location on the screen's vertical axis. Note, however, that
as you stamp buildings on the page, their tops stay at approximately
the same height on the page. This is because the top of the brush
coincided with the perspective center when you fixed the y-axis. You
can change this now by shifting the brush along its y-axis, as follows:

C'- Hold down the Shift key and press the ' (apostrophe) key. This
moves the brush along its (fixed) y-axis, moving it down below eye
level.

Now as you move the brush up and down the page, the top of the brush
moves up and down as well. Thus, by using the apostrophe key, you
can fine-tune the brush's location on its fixed axis, changing its
position relative to the viewer's point of view.

Note, however, that you can control this effect another way, just as we
did when we rotated the brush in the first exercise. When you fixed
the y-axis above, the top of the brush outline was level with the
perspective center. If the brush outline had been towards the bottom
of the page when you fixed the y-axis, the result would have been
different. Try it. Reset all the axes to zero, move the brush to the
bottom of the page, and fix the y-axis. Now as you move the brush up
and down, its top moves as well. This illustrates the second important
rule of perspective:

The location of the brush outline at the time you fix an axis determines
the position of the brush on its fixed axis relative to the view plane.
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Try the following as an exercise for yourself: reset the perspective
center to a point about two thirds down the page, and then fix the y
axis in a way that allows the bottom of the buildings to be
approximately level, providing more of a street-level perspective.
(Hint: the same principle applies that applied in the previous
exercise when we fixed the tops of the buildings).

Congratulations! You have just completed a series of tutorials
designed to make you a DeluxePaint power user. But while the
preceding tutorials cover most of DeluxePaint's important features,
they couldn't cover everything. If you need information on any feature
not covered in the tutorials or any of the preceding sections, you can
look it up in the following chapter, the Reference section.
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This chapter describes every one of the DeluxePaint's features. First,
it discusses menu items, menu by menu; then tools in the Toolbox; and
finally, keyboard commands and cursors. Refer to this chapter when
you want to look up information quickly about a certain feature of the
program.

As you press down the mouse button and move the pointer horizontally
across DeluxePaint's Menu Bar, one after another of the menus drops
down to reveal its selection of options. Moving the cursor down the
selection of options highlights each one. Releasing the mouse button
when a menu option is highlighted selects that option. If the option
name is followed by ellipses (...), a dialog box appears after you select
the option. There, you type information or select additional options;
then you click OK to accept your new information or Cancel to leave
the dialog box without making any changes.

In many cases, you can select a menu item by using its keyboard
equivalent. Keyboard equivalents, where available, are given in the
descriptions that follow. You can find a table of keyboard equivalents
at the end of the Reference Section and in your Reference Card. Before
you use a keyboard equivalent, make sure the cursor is not pointing at
the Menu Bar, or your keystroke will have no effect. One keyboard
equivalent deserves special mention: a (the "Again" key) invokes your
last menu option, whatever it may have been. For example, if your
last menu option produced a dialog box (e.g., a save or load dialog
box), then pressing a produces the same dialog box.

The menus, reading from left to right across the Menu Bar, are as
follows:
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APPLE (It) MENU

The Apple menu gives you copyright information about DeluxePaint
and lists your lIeS desk accessories.

ABOUT DELUXEPAINT...

Gives the name of the program, the date and version number,
copyright information, and developers' names.

DESK ACCESSORIES

Lists the mini-applications that you currently have access to (such as
a clock, calculator, or notepad). See your IIGS documentation for
information about desk accessories.

FILE MENU

The File menu lets you load and save pictures, brushes, and stencils,
and print pictures.

LOAD PICTURE...

Brings up the Load Picture Dialog Box (refer to Figure 1.4). To change
to a different drive, click Disk. Click the name of the file you want to
load. (If your file is in a folder, open the folder first by double
clicking.) If there are more items in the directory than there is room in
the window, you can scroll through the directory by clicking the up
and down arrows in the scroll bar or by dragging the scroll box up and
down. If you change to a different drive or you swap disks while the
Load Picture Dialog Box is displayed, DeluxePaint reads and displays
the new disk's directory. Click Open to load the selected file, or
Cancel if you change your mind.

SAVE PICTURE...

Brings up the Save Picture Dialog Box (refer to Figure 1.3). To change
to a different drive, click Disk. You can save a picture by typing a
filename (up to 15 characters long) in the Save Picture box. Click Save
to save your file, or Cancel if you change your mind.
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To create a new folder, type the folder name in the Save Picture box,
then click New Folder. When the new folder name appears in the list,
double click to open it. Then save your current picture in a file in the
new folder by typing the filename and clicking Save.

Pictures are saved and reloaded with all their attributes, such as
palettes, stencils, and perspective information. Note that the spare
screen is not saved.

LOAD BRUSH...

Brings up the Load Brush Dialog Box. This is identical in function to
the Load Picture Dialog Box (see above), except that you are loading a
brush rather than a picture. If you load a brush that has a palette
different from that of the current picture, the picture palette will
remain in effect. Nonetheless, the brush palette information is loaded
along with the brush; you can change to the brush's palette by
selecting Use Brush Palette from the Color menu (see below). If you
wish to revert to the previous palette, use Restore Palette, also from
the Color menu.

SAVE BRUSH...

Brings up the Save Brush Dialog Box. It is identical in function to the
Save Picture Dialog Box (see above). Brushes are saved with their
palettes, which includes color cycling information.

LOAD STENCIL..

Stencils can be loaded (and saved, see below) as separate items. They
are full screen only, and can be loaded only to the position they
occupied when they were created. When loaded, stencils consist
simply of a masked area and a "cut-out" area of the screen. You can
lay down paint only on the cut-out area. The Load Stencil Dialog Box
is identical to all other Load Dialog Boxes.

SAVE STENCIL...

You can save (and load, see above) stencils just as you can any other
file, such as pictures or brushes. DeluxePaint saves your stencil as a
"mask" with holes in it: The areas that were unlocked colors are the
"cut outs" on the mask. DeluxePaint does not save any color
information with the stencil. The Save Dialog Box for stencils is
identical to those for other types of files.
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CHOOSE PRINTER...

Lets you specify the printer you are using (such as ImageWriter or
LaserWriter), and the port it is connected to (such as the printer port).
Make sure all the information in this dialog box is correct before you
use the Page Setup or Print options below.

PAGE SETUP...

Brings up the Page Setup Dialog Box, letting you specify how
DeIuxePaint will print your artwork on the page. For example, you
can specify the size of the paper you are using and its orientation (that
is, whether it will print upright or sideways). The options in the
Page Setup dialog box may differ depending on the printer you have
selected. Make sure the information in this dialog box is correct before
printing your artwork using the Print option below.

PRINT...

Prints your current artwork. Make sure that your printer is connected
and turned on; then click OK. Once your printer starts printing your
artwork, you can stop printing by holding down the Command key and
pressing the period (.).

QUIT

Leaves DeIuxePaint and returns you to your previous environment.

The Edit menu lets you place DeIuxePaint images on the lIes
Clipboard (to copy to other lIes applications) and copy images from
the Clipboard. It also lets you display additional information on the
screen (Coordinates and the Info Bar) and make certain changes in your
brush.

UNDO

Cancels the last drawing action. Same as Undo in the Toolbox.
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CUT

Cuts an image and places it onto the Clipboard, replacing its previous
contents. This allows you to move text or images between different
applications. See your Reference Card for more information. See also
Paste, below.

COPY

Copies an image and places it onto the Clipboard, replacing its
previous contents. This allows you to move text or images between
different applications. See your Reference Card for more information.
See also Paste, below.

PASTE

Pastes the contents of the Clipboard (such as graphics or text from
another application) into the current application. See your Reference
Card for more information.

FAST FEEDBACK

As you draw with the Line or Unfilled Shape tools, gives you
immediate feedback using the smallest (one-pixel) brush. Next,
DeluxePaint completes the design using the currently selected brush.
Use this to increase response speed while you are working with large
or complicated brushes. Toggle Fast Feedback off by selecting it a
second time.

COORDINATES

Turns on the coordinate display in the right-hand portion of the Info
Bar. (You must, of course, first turn on the Info Bar.) Moving the mouse
without holding a button down displays coordinates for the current
position of the cursor, relative to the origin. Initially, the origin (0, 0)
is set to the upper left-hand corner of the screen. Pressing and holding
down the mouse button temporarily resets the origin to the current
cursor position and displays the displacement value from that
temporary origin when you move around the screen. (The readout is
scaled in pixels.) If selected, Coordinates are displayed instead of
Axis Rotation information in Perspective mode.
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INFO BAR

Toggles the Info Bar at the bottom of the screen (see Figure 1.1). The
Info Bar displays the following information:

PAINTING MODE: At the left of the Info Bar is the current painting
mode <Matte, Color, Replace, Smear, Shade, Blend, Cycle, Smooth).
See Mode menu, below, for information on painting modes.

COLOR FILL BOX: This box (in the left center of the Info Bar)
displays the currently selected pattern fill, gradient fill, or
perspective fill. This is the pattern or gradient fill you will get when
you fill a shape. The Color Fill Box is absent if fill mode is set to
Solid. See discussion under Fill tool, below, for more information on
the Fill Type Dialog Box.

S: This notation appears in the center of the Info Bar when a stencil is
active.

B: This notation appears in the center of the Info Bar when the
background is fixed.

AXIS ROTATION: When you are in Perspective mode, the amount of
rotation about each axis (x, y, and z, respectively) appears at the
right of the Menu Bar. Axis rotation information does not appear if
Coordinates is selected.

COORDINATES: When Coordinates (Edit menu) is selected, the
coordinates of the cursor position are displayed at the right of the Info
Bar. See the Coordinates option, above. If selected, coordinates are
displayed instead of the Axis Rotation information in Perspective
mode.

MEMORY AVAILABILITY: If you press the CfRL key and a at the
same time, the amount of remaining memory is displayed at the left
side of the Info Bar. See the Reference Card for information on
DeIuxePaint's memory usage.
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BRUSH HANDLE

EXCLBRUSH

The image picked
up with

Exct Brush on

An image on
the screen

The image picked
up with

Exct Brush off

Lets you specify whether you'll hold your custom brush directly by its
center (the default) or by a "handle" on one of its corners. Select Brush
Handle if you want to hold your custom brush by a corner (as marked
by the arrow cursor). The location of the handle depends on the
direction you drag the mouse when you pick up the brush. If you drag
down and to the right, the handle will remain at the lower right. If
you drag up and to the left, the handle will move to the top left. The
same principle applies if you drag down and to the left or up and to
the right. In other words, the corner you drag to is the one the handle
will attach to. Holding a brush by its Brush Handle is particularly
useful in Perspective mode (see Brush menu, below).

4.7

Figure 4.1. An Example of Using Excl Brush (Assume Grid is On)
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To turn off Brush Handle and hold your brush by the center, select
Brush Handle again (so it is not checked on the Edit menu).
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If you pick up a brush with Excl Brush (and the Grid) selected, you
will exclude a one-pixel border on the right and bottom edges (see
Figure 4.1). This is useful if your brush has a colored border around it
and you want to use the brush to create a pattern fill or perspective fill
(using the Fill Type Dialog Box). When DeluxePaint creates your
pattern, the border remains a uniform width throughout instead of
being twice as wide where one copy of the brush is placed next to
another.



PAGE SIZE...

SQUARE ASPECf
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Set Page Size

@ Screen Size (320 x 200)
o Custom Size

Width: I~ I Height:1200

The Pict menu lets you work with stencils, backgrounds, and the spare
page, and set screen resolution and page format. The Pict menu
contains the following menu items:

Because the IIGS pixels are not perfectly square, squares and circles
drawn with the shape tools are not perfectly square or round on the
screen. (They will look better when printed, however.) If you wish to
make any squares or circles you'll draw appear "true" on the screen,
select Square Aspect from the Edit menu. This will square all the built
in brushes, the appropriate shape tools, and symmetry. Square Aspect
does not square gridding or perspective.

Brings up the Set Page Size Dialog Box (see Figure 4.2). You can select
the finished size of your painting (page size) that you wish to work
on.

Figure 4.2. Set Page Size Dialog Box

Click one of the two radio buttons - Screen Size or Custom Size. If you
select Custom Size, also type the desired width and height (in pixels)
in the appropriate boxes. Click OK when the Page Size is set as you
want.

Screen Size gives you a painting that is the size of your IIGS screen.
Custom Size lets you specify your own page width and height. The
maximum page size is twice the area of the screen. Examples of
maximum page size in Medium Resolution are 320 x 400 and 640 x 200.

PICT MENU
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If your page size is larger than screen size, use the four Arrow keys to
scroll to off-screen portions of the page. Or select Show Page (below)
to see your entire painting on the screen in reduced form.

SCREEN FORMAT...

'Ibis brings up the Choose Screen Format Dialog Box {refer to Figure
2.3}. This dialog box gives you the following options:

320 x 200, 16 colors: This is the default setting (called Medium
Resolution). It gives you a pixel array of 320 x 200 and lets you have
up to 16 colors on the screen.

640 x 200, 4 colors: This is the Hi.gh Resolution setting. It uses a
pixel array of 640 x 200 and allows 4 colors.

In general, you should decide on a screen format for your painting and
continue with that format. You cannot change screen formats while
your painting is on the screen, and you can only reload a picture in the
format in which it was saved.

See the Reference Card for a discussion of memory requirements.

SHOW PAGE (Keyboard Equivalent: Shift-S)

Displays your current painting in its entirety in a reduced format - for
example, with a 64D x 400 page size in Medium Resolution, it shows
only every other pixel. Pressing any key or the mouse button returns
you to your current painting in full size.

MAKE STENCIL...

Lets you create a stencil of an image by "locking" the colors that
comprise that image. Then you can paint around the image without
painting on it, as though it were protected by a stencil.

Selecting Make Stencil brings up the Make Stencil Dialog Box (see
Figure 3.2). Click the colors to use in creating the stencil. A black
vertical bar appears to the right of "locked" colors. These colors will
define a mask that protects an area from being painted. You can select
colors by clicking in the dialog box palette.
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Clear the current color selections by clicking Clear. Reverse the colors
in the dialog box that are locked by clicking Invert. When vertical
bars appear to the right of all the colors you wish to protect, click
Make. The letter S appears in the Info Bar when you have a stencil
active. Note that the shape of the stencil (the mask) is what is
created and stored in memory, not the color information, which means
you can change the colors in the unmasked area, and still retain the
stencil.

When you have a stencil active and you apply colors onto your picture,
the colors you apply are not protected, even though they may be
locked in the Make Stencil Dialog Box. You can lock newly-applied
colors by bringing up the Make Stencil Dialog Box again and clicking
Make.

REVERSE STENCIL

Reverses the areas on your screen that are locked. Does not depend on
the color information in the Make Stencil Dialog Box. Suppose you
lock the color blue in the Make Stencil Dialog Box and make a stencil.
Later you toggle the stencil off and paint with blue on the part of your
painting that is masked in your stencil. If you toggle the stencil on
again and select Reverse Stencil, you reverse the masked and
unmasked areas of your stencil and you can paint anywhere on the
newly unmasked area (even in the blue areas). DeluxePaint "forgets"
that you previously locked this color in the Make Stencil Dialog Box.

LOCK FOREGROUND

The Make Stencil Dialog Box lets you create stencils based on colors in
the palette. By locking a color, you are making it impossible to paint
on, wherever it may be on the page. By using a combination of Fix
Background (see below) and Lock Foreground, however, you can define
a stencil by area rather than color. (You don't need to use the Make
Stencil Dialog Box.) When you select Lock Foreground, you lock those
areas on the page that you have painted since fixing the background,
regardless of the color of those areas. (In other words, those areas
form the masked part of your new stencil.) When you lock a
foreground, your subsequent painting is added behind the foreground
and in front ofyour fixed background.

TOGGLE STENCIL (Keyboard Equivalent 'to the left of the
Spacebar)

Toggles the current stencil on and off. This lets you maintain the
stencil in memory but turns it off temporarily so you can paint on the
locked colors.
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FREE STENCIL

A stencil uses memory even though the stencil is turned off (see Toggle
Stencil, above). Free Stencil removes the stencil from memory.

FIX BACKGROUND

Fixes the background by "locking" the current picture, while allowing
you to draw on top of it. You can erase any work you have done since
fixing the background by clicking CLR or by painting while holding
down the Command key and the mouse button. Fixing the background
uses additional memory. Note that when the background is fixed, you
cannot pick up any image painted before you fixed the background.

FREE BACKGROUND

This "unlocks" the background, so that clicking CLR will clear the
entire picture. It also frees up the memory that was allocated to
saving the background.

SPARE PAGE <Keyboard Equivalent: j)

Displays the spare page. (By definition, the spare page is always
"the other page," the one that is not currently displayed.) Because
you have two pages to work with, you can create brushes in one and
import them to the other for final placement against a background.
When you first call it up, the spare page is the standard screen size. If
you wish to use a larger page size on the spare page, you will need to
make the appropriate selection from the Page Size option (see above).
Note, however, that you can increase the size of a page only if you
have sufficient memory available. Note also that a spare page uses
up memory, even if there is nothing on it.

COPY TO SPARE

Copies the picture on the current page to the spare page. This lets you
experiment with your picture on the spare page without fear of losing
anything. If you do not have sufficient memory for a spare page, save
the image to disk if you wish to experiment with it.
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CHAPTER FOUR: REFERENCE

DELETE THIS PAGE

If you no longer wish to have memory allocated for a second page, use
Delete this Page to delete the current page (the one currently showing
on the screen) and to deallocate the memory set aside for it. Be sure
you have saved a copy of the picture you are deleting if you think you
may need it later. When you select Delete this Page, DeluxePaint
asks you to confirm the deletion, and then switches you to the other
page.

Lets you modify the way your brush lays down paint and lets you make
subtle changes to paint that has already been laid down.

MATIE (Keyboard Equivalent: 1)

Uses a custom brush in its multicolor form. Those areas of the brush
matching the current background color are transparent. This is the
default mode when you create a custom brush using the Brush Selector.
Mter you have used your brush with Color or Cycle, selecting Matte
restores your custom brush in its previous multicolor form (assuming you
haven't changed background colors).

COLOR (Keyboard Equivalent: 2)

Uses the shape of the custom brush and fills it with the current
foreground color. Those areas of the brush matching the current
background color are transparent.

REPLACE (Keyboard Equivalent: 3)

Uses the custom brush in its original multicolor form (i.e., Matte, see
above), except that no colors are transparent.

SMEAR (Keyboard Equivalent: 4)

With Smear selected, you can smear any colors on the page by dragging
a brush over them. This is like smearing a wet oil painting with your
fingers, so the bigger the brush, the more pronounced the effect. Smear
uses only the colors under the brush, does not add any new colors, and
does not depend on color ranges. Smear ignores the current brush color
but uses its shape.
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SHADE (Keyboard Equivalent: 5)

With Shade selected, you can create subtle shading effects on those
colors in your picture that are in a cycle range. You select the range you
want to work with by selecting a foreground color in that range. Then,
if the color under your brush is in that range, Shade paints over the
color under your brush with the next color in that range. (For example,
if one of your ranges consists of white, pink, and red and you have
selected a current foreground color in that range, you can paint over
white with pink, and you can paint over pink with red, and so on.)

You can paint with the next-higher color in the range by pressing the
mouse button, and the next-lower color by holding down the Command
key and the mouse button. "Higher" and "lower" are relative to the
color under the brush at the time. If the current foreground color is in a
cycle range, Shade has no effect on colors outside that range. If the
current foreground color is not in a cycle range, Shade paints over all
colors under the brush. treating the entire palette as a cycle range. If
the current foreground color is a member of more than one range,
DeluxePaint selects the lowest numbered range.

BLEND (Keyboard Equivalent: 6)

Like Smear, above, Blend drags the colors under the brush and runs
them together. Unlike Smear, however, Blend looks at the current
foreground color and cycle ranges (as well as the colors under the
brush). And instead of laying down only the colors under the brush
(like Smear), Blend "averages" the colors under the brush and lays
down these colors. Blend averages colors numerically depending on
their order in the palette. For example, the "average" of Colors 7 and
9 is Color 8, regardless of whether Color 8 is red, black, or some other
color.

You select the range you want to work with by selecting a current
foreground color in that range. If the current foreground color is in the
same range as the colors under the brush, Blend adds blending colors
within that range. If the current foreground color is in a different
range from the colors under the brush, Blend will have no effect on the
page. If the current foreground color does not fall within any color
range, Blend uses blending colors throughout the entire palette.
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CYCLE (Keyboard Equivalent: 1)

Uses the current brush shape and cycles through all the colors in the
currently selected range as you draw. A range is selected if one of its
members is selected. If a color is a member of more than one range,
selecting it selects the lowest-numbered range. If your current brush
color is not within a cycle range, DeluxePaint paints with that color
only. Using Cycle with a multicolored brush treats the brush as if it
were a single color (the current foreground color) and then cycles
through that range.

Using Cycle and Multi-Cycle (below) with a multicolored brush
causes each color in the brush to cycle through its range independently
of the others, as you draw.

Note: The Cycle option in the Color menu has a different function: It
turns on a flashing animation effect in the painting that is already on
the screen.

SMOOTH (Keyboard Equivalent: 8)

Reduces the contrast between two adjoining areas (without depending
on the current foreground color or cycle ranges). Smooth looks at the
colors under the brush, finds one or more colors anywhere in the palette
that fall on the color spectrum between the colors under the brush, and
paints the boundary in these colors. Smooth doesn't average colors
numerically like Blend, but averages colors based on their RGB/HSV
settings. For instance, if averaging light and dark blue, Smooth will
look on the palette for the color closest to a medium blue. If the
palette contains a wide selection of colors close to the ones under the
brush (e.g., the selection of blues), Smooth will have more colors to
draw from to create its weighted averages. Useful for creating
airbrush effects by smoothing out contrasting boundaries, or for
eliminating jagged edges.

MULTI-CYCLE

Use this in conjunction with Cycle (see above). When Multi-Cycle is
turned off (the default state), using the Cycle paint mode with a
multicolored brush treats the brush as though it were a single color
(the current foreground color). With Multi-Cycle turned on, painting
with a multicolored brush in Cycle mode cycles every color in the
brush, provided the brush color is in a cycle range. Note that Multi
Cycle actually alters the colors in a brush, so be careful! After you
select Multi-Cycle, you cannot restore the previous version of your
brush.
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The Brush menu lets you modify custom brushes (Le. resize, flip,
rotate, and bend) and create three-dimensional paintings (using the
Perspective option).

FLIP HORIZONTAL (Keyboard Equivalent: x)

Hips the current brush along the horizontal or x-axis.

FLIP VERTICAL (Keyboard Equivalent: y)

Hips the current brush along the vertical or y-axis.

ROTATE

Lets you rotate your current brush any number of degrees. Hold down
the mouse button and drag the rectangular outline to rotate it about its
bottom left corner; release the button at the desired orientation. If you
select this option more than once, your brush will revert to its original
orientation before you rotate it again.

STRETCH (Keyboard Equivalent: Shift-Z)

Lets you stretch your brush in any direction to any size, larger or
smaller than the original. Hold down the mouse button and drag in
any direction to stretch the brush. Release the button when the brush
is the desired size. You can constrain the stretching so that the ratio
of height to width remains the same by holding down the Shift key as
you stretch. Stretching a brush uses up memory; if you try to stretch a
brush to a size bigger than the available memory can accommodate,
the brush will snap back to its original size.

HALVE (Keyboard Equivalent: h)

Reduces the size of your brush by 50% in both dimensions.

DOUBLE (Keyboard Equivalent: Shift-H)

Doubles the size of your brush in both dimensions, for a quadrupling of
the total area.

BEND HORIZONTAL

Lets you bend the current brush in a horizontal direction. With the
mouse button held down, drag the brush outline left or right until it is

4.15



CHAP TER F0 UR: REF ERE NeE
,

the desired shape and release the button. Dragging the cursor up or
down determines where the bending occurs.

BEND VERTICAL

Lets you bend the current brush in a vertical direction. With the mouse
button held down, drag the brush outline up or down until it is the
desired shape and release the button. Dragging the cursor left or right
determines where the bending occurs.

SHEAR

For controlled distortion of the current brush. The top part of the brush
is anchored, and you can drag the bottom of the brush in either
direction.

OTHER BRUSH FUNCTIONS:

You can select the following two brush sizing functions only through
the keyboard:

DOUBLE HORIZONTAL (SHIff-X)
Doubles the size of your brush in the horizontal dimension.

DOUBLE VERTICAL (SHIFf-Y)
Doubles the size of your brush in the vertical dimension.

Note: When you modify a brush (e.g. Halve it) and then want to
restore your previous brush, Command-dick the Brush Selector, or
press Shift-B.

PERSPECflVE

This operates only when you have a custom brush currently active.
When you select Perspective on the Brush menu (or press Enter on the
keypad), a perspective center is shown and your brush temporarily
changes into a four cell matrix (the Perspective Brush outline). You
can then rotate this brush outline about any or all of its three axes x, y,
and z (see Figures 3.3 and 3.4). The amount of rotation for each of the
three axes is given in degrees at the right-hand side of the Info Bar.
(To display this, you must have the Info Bar displayed and
Coordinates turned off.) You can paint an image of the rotated brush
at any time by clicking the mouse button.

Note: Many perspective functions are performed with keys on your
keypad. Ifyou don't have a keypad, see your Reference Card.
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SETIING THE CENTER: To set the perspective center (which
corresponds to the viewer's eye level), press the Decimal Point key on
the keypad. Your cursor changes into a large crosshair. The smaller
stationary crosshair on the screen denotes the existing center. Move
the center of the large crosshair to the desired perspective center and
press the mouse button.

Once you have set the perspective center, the position of the unrotated
brush relative to that center determines the brush's position on the
fixed axis (see below) upon rotation. For example, with the z-axis
fixed (the default), the position of the brush outline relative to the
perspective center when the brush is rotated determines the rotated
brush's position on its z-axis. The greater the distance above or below
eye level on the z-axis, the more pronounced the perspective effect.

AXIS ROTATION: All x-axis manipulations are controlled through
the top row of the keypad. To rotate the brush about its x-axis so that
the top of the brush moves away from you, press Keypad 8 for each
degree of rotation. To rotate the brush about the x-axis in the opposite
direction (so that the top of the brush moves towards you), press
Keypad 7. To return to zero rotation for that axis, press Keypad 9.

All y-axis manipulations are controlled by the middle row of the
keypad. To rotate the brush about the y-axis so that the right side of
the brush moves away from you, press Keypad 5. Press Keypad 4 to
rotate the brush in the opposite direction, and press Keypad 6 to return
to zero rotation for that axis.

All z-axis manipulations are controlled by the bottom row of the
keypad. To rotate a brush clockwise about the z-axis, press Keypad 1.
Press Keypad 2 to rotate the brush counterclockwise about the z-axis,
and press Keypad 3 to return to zero rotation.

To rotate about an axis through a larger increment, hold down the
Shift key as you press the appropriate number. This increment
defaults to 90 degrees, but you can set it to any other angle by calling
up the Grid Dialog Box when in perspective mode. To do this,
Command-elick the Grid icon. See discussion below under The Toolbox.
Pressing Keypad 0 resets all three axes to zero and fixes the z-axis (see
below), but retains the apparent distance settings. Pressing Keypad 0
in conjunction with the Shift key resets all perspective values to the
default (boot-up) state, including resetting the perspective center.

The; and I keys move the brush plane forward or back along its fixed
axis (see below) without changing its orientation, moving it in a
direction perpendicular to the brush plane. This has the same effect
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described in the above discussion on brush position prior to rotation.
Thus, with the z-axis fixed, brush position relative to the perspective
center at the moment of rotation determines the brush's distance above
or below eye level. You can achieve the same effect after the brush is
rotated by using the; and I keys to move it forward or back along its z
axis. Pressing these keys with the Shift key held down results in
larger increments of movement. In addition, you can modify the
apparent distance from the observer by pressing the < and > keys (Le.,
the Shifted "," and "." keys). Thus, when the apparent distance is
great, the perspective foreshortening is at a minimum, becoming
greater as apparent distance decreases.

FIXING AXES: Whenever you start in perspective mode, the z-axis
(the one perpendicular to the screen) is "fixed," that is, the mouse does
not move the brush along that axis. You can selectively fix any axis,
as follows:

To fix the x-axis, press Shift-Keypad 9
To fix the y-axis, press Shift-Keypad 6
To fix the z-axis, press Shift-Keypad 3

As noted above, you can move along the axis that is currently fixed by
using the Shifted or un-Shifted ; and I keys (use the Shifted keys for
larger increments).

The position of the brush outline at the moment you fix an axis is also
important. For example, if the center of the brush outline corresponds
exactly to the perspective center at the moment you fix the y-axis
(which causes back-and-forth - toward you and away from you 
mouse movement to translate into movement along the screen's z-axis),
then movement along the z-axis will be at eye level, so the brush
outline will simply become bigger or smaller as you move the mouse
back and forth. On the other hand, if the top of the brush outline is
below eye level at the moment you fix the y-axis, then movement
along the z-axis will be on a plane below eye level.

Once you have rotated the outline to the desired orientation, you can
place a copy of the modified brush on the page by clicking the mouse
button. The other brush options work in Perspective mode as well,
including the options available through the Brush menu (see above).
For example, if you want to hold your brush outline by the corner
rather than the center, you can select Brush Handle from the Edit
menu. This moves the arrow cursor to the lower right corner of the
brush. When you rotate a brush about an axis, it is rotated about the
arrow cursor, so its location is important when you are in Perspective
mode.
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OPTIONS...

Figure 4.3. Perspective Options Dialog Box

l) (Cancel)OK

Perspective Options
Rotation:
@ Absolute
o Relative
Anti-A I iasing:
@Hone
OLowo High

ROTATION
Absolute: Default; uses x, y, z Euler method, measures all three
angles of rotation from absolute zero. Angles of rotation are
displayed on the Info Bar.

Relative: Rotates angles relative to the current brush rotation.
Angles of rotation are not displayed on the Info Bar.

( P lace Center)

Displays the Perspective Options Dialog Box, which lets you change
rotation modes and toggle anti-aliasing on and off (see Figure 4.3).

The Perspective Options Dialog Box provides the following options:

KEYBOARD COMMANDS: For a list of the keyboard commands
available in Perspective mode, see Keyboard Commands and Cursors,
below.

EXITING PERSPECTIVE MODE: To exit Perspective mode, click one
of the drawing tools.

You can also fill any enclosed space with perspective fill. In
Perspective mode, rotate your brush as desired. Then Command-click
the Fill tool to bring up the Fill Type Dialog Box (refer to Figure 2.6,
above) and click on Perspective. From that point on (until you turn it
off by clicking another Fill type), any fill operation (using either the
Fill tool or the Filled Shape tools) will use perspective fill.
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ANTI-ALIASING
None: Default; anti-aliasing is off.

Low: Lets you eliminate some of the jagged outline on your
perspective brush. Jagged lines are most noticeable when an image
has been rotated and/or shrunk. The brush will be painted more
slowly than with anti-aliasing off. To use anti-aliasing, select
either Low or High (see below) before you lay down the brush
image. Anti-aliasing is most effective when you have reduced the
size of your original brush (for example, by moving it back along the
z-axis).

High: This is similar to Low (see above) but with a much more
pronounced effect. The brush will be painted much more slowly
than with anti-aliasing off.

The Color menu lets you modify your current palette and load various
other palettes.

PALETIE... (Keyboard Equivalent: p)

Brings up the Palette Window (refer to Figure 2.4). You can also bring
up the Palette Window by Command-elicking the Color Indicator
(between the Main Palette and the Toolbox). This window lets you
modify your palette and set color ranges. To start working with a
color, click the color in the mixing palette. The black rectangle (called
the Color Selector) will move to the color you select. Move the scroll
boxes in the RGB (for Red, Green, and Blue) or HSV (for Hue,
Saturation. and Value) scroll bars to change the color.

To get numerical R, G, B, H, 5, and V settings, press the n key when the
Palette Window is displayed. This brings up the Color Settings
Dialog Box (Figure 4.4). Here, the scroll box positions on the R, G, B,
H, 5, and V scroll bars are converted to numbers. The numbers range
from 0 to 15 for R, G, and B and from 0 to 255 for H, 5, and V. The
numerical settings for a pure red are shown below. To duplicate a color
on a later palette or on a different computer, display this dialog box
and write down the numerical settings for that color.
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Color Settings

Red: 15
Green: 0
Blue:O

Hue: 0
Saturation: 255

Value: 255« OK »
Figure 4.4. Color Settings Dialog Box

DeluxePaint uses Colors 1 and 16 to draw dialog boxes and the Toolbox.
Therefore, it does not allow you to select similar colors for Colors 1 and
16 (such as black and dark blue) or you wouldn't be able to read the
dialog boxes, etc.

To copy a color from one position to another, click the first color, click
Copy, then click the position you want to copy it to. To swap the
position of two colors, click the first color, click Swap, and then click
the second color. If you use this to rearrange colors in your Palette and
find that the colors in your painting are scrambled, use the Remap Pid
option to return the picture to its original appearance (see Remap Pict
below). To create a spread of shades between two colors, click the first
color, click Spread, and then click the second color. DeluxePaint
creates a uniform spread of colors, taking into account the beginning
and ending shades and the number of colors in between.

The Range feature controls color cycling, gradient fill and Shade and
Blend. You can create four color ranges using the Range command.
Click one of the four radio buttons after'Range (1, 2, 3, or 4), then move
the ends of the bracket that is at the right of the mixing palette. To
change a range, simply repeat the process. To cancel a range, create a
range of one color: that is, move the ends of the bracket until they
both point to only one color. Once you have defined a range of colors,
selecting any of the colors in the range selects the entire range.

You can control the speed of the color cycling for each range by
dragging the Speed scroll box to the left (slower) or to the right
(faster). By holding the mouse button down on the scroll box, you can
monitor the color cycling speed on the-page, even if Color Cycling is
turned off. You can control the cycle direction for each range by
clicking on one of the two cycle direction arrows to the right of the
Speed. scroll box while that range is selected.
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You can reverse the last change you made in the Palette Window by
pressing u on the keyboard. To accept your changes and return to your
painting, click OK. (Clicking outside the Palette Window has the
same effect as clicking OK.) If you don't wish to use any of the changes
you've made, click Cancel to return to the page as you left it. If you
accept your changes and then decide to return to the previous palette,
select Restore Palette from the Color menu (see below).

RESTORE PALETTE

This returns you to the palette you ~ere using before the current
palette. Thus, if you load a picture with a different palette, Restore
Palette reverts to the palette in effect before the load. See Use Brush
Palette and Default Palette below.

DEFAULTPALElTE

The default palette is the one DeluxePaint always uses when you first
start the program. The Default Palette command replaces the current
palette with the default palette.

CYCLE (Keyboard Equivalent: Tab)

Toggles color cycling on/off in your painting (see Palette, above).
Here, the colors already on the screen cycle through their respective
ranges, and a flashing animation effect is created. If a color is not
included in any range, it does not cycle. See Animation with Color
Cycling at the end ofTutoriall in Chapter 3.

To cycle through colors while drawing with a custom brush, use Cycle
and Multi-Cycle in the Mode menu.

BACK->FORE PICT

Changes the color currently designated as the background color to that
currently designated as the foreground color. This provides an easy
method of changing colors throughout the page - that is, all pixels in
the current background color in the picture are changed to the current
foreground color. Use this option, for example, if you simply want to
change all occurrences of light blue in your painting to a darker shade
of blue from your palette. The change occurs onscreen only and does not
affect the order of colors in the Palette. Undo does not reverse this
change.

BACK<->FORE PICT

Swaps all pixels in the current background color with the current
foreground color. This is similar to the Back->Fore Pict option above,
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USE BRUSH PALETfE

BACK->FORE BRUSH

REMAPPICf

•BACK<->FORE BRUSH

except that the change occurs in both directions. This option changes
the colors in your painting only and does not change the order of colors
in the Palette. Like Back->Fore Pict, above, Undo does not reverse
this change.

When you create a picture, DeluxePaint "remembers" each color on the
screen by remembering its location in the palette. If a picture on the
screen was created with a palette other than the current palette (for
example, if you modified the palette since loading the picture),
Remap finds the locations in the current palette of the colors it used in
the original palette and "tells" the picture to look there for its colors.
Back->Fore Pict and Back->Fore Pict, above, are special cases of
Remap. See also Remap Brush, below. Undo does not reverse this
change.

When you load a brush, DeluxePaint continues to use the current
picture palette, even though it may be different from the one the brush
was created with. Use Brush Palette switches to the brush palette,
and includes any information about color cycling that was saved with
the brush. Remap Brush, below, lets you keep the current picture
palette, but maps the brush to the picture palette for a best fit.
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Swaps the current background color in the brush with the current
foreground color. This is similar to the Back->Fore Brush option
above, except that the change occurs in both directions. The change
affects the brush colors only and does not affect the picture or the order
of colors in the Palette.

Changes all pixels in the brush of the color currently designated as the
background color into that currently designated as the foreground
color. This provides an easy method of making a global color change
- all instances of the background color in the brush are changed to the
current foreground color. You can select any color in the brush as either
the foreground or the background color at any time, thereby letting you
make intricate color changes easily. The change affects the brush
colors only and does not affect the picture or the order of colors in the
Palette.



PLAIN

REMAP BRUSH

BOLD

Select a font by

OUTI.INE

Returns to the regular (plain) style from bold, outline, and/or
underline. This is the default style.

Lets you select fonts and styles (e.g., plain, bold, or underlined) for
text. To enter text, press t from the keyboard or click the Text Icon on
the Toolbox. See discussion on the Toolbox below for more information.

Lets you choose from the available fonts.
highlighting it and releasing the mouse button.
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Use Remap when you load a brush that uses a palette different from
the current palette. Remap looks at the colors used in the brush and
tries to find the closest fit within the current palette. Different from
Use Brush Palette, because it does not change the palette, but only the
palette loeations the brush looks in for its colors.
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FONTS

Toggles boldfacing on/off. When on, DeluxePaint paints the current
font in boldface. Selecting Bold a second time turns it off.

Toggles outline text on/off. When on, DeluxePaint paints the current
font outlined. Selecting Outline a second time turns it off.

Toggles underlining on/off. When on, DeluxePaint paints the current
font underlined. Selecting Underline a second time turns it off.

8 POINT, 1 OINT ... 16 POINT

Selects font size.

FONT MENU



f) TOOLBOX (refer to Figure 1.2)

Like some of the menu items above, most of the tools in the Toolbox are
available through keyboard equivalents. As you become proficient
with DeluxePaint, you will find it more efficient to use these
equivalents, using one hand for the mouse and the other hand for the
keyboard. Where appropriate, the following descriptions of the tools
include the keyboard equivalents. And to help you learn these, we
have suggested a mnemonic for each one.

BUILT-IN BRUSHES

The Toolbox contains ten built-in brushes at the top. Click a brush to
select it. Command-click to invoke the size option. To increase the
size of the selected brush, drag the mouse while holding down the
mouse button; to decrease the brush size, drag the mouse while holding
down the Command key and the mouse button.

DOTTED FREEHAND TOOL
(Keyboard Equivalent s; Mnemonic: sketch)

Draws a series of "splats" of the current brush shape. Spacing between
splats is a function of the speed with which you move the mouse.

CONTINOUS FREEHAND TOOL
(Keyboard Equivalent d; Mnemonic: draw)

Draws a continuous freehand line.

STRAIGHT LINE TOOL
(Keyboard Equivalent v; Mnemonic: vector)

Draws a straight line using either the current foreground color (if
you're holding down the mouse button) or the current background color
(if you're holding down the Command key and the mouse button).
Press and hold the button while you drag the mouse to the line's end
position and then release the button.

Holding down the Shift key while drawing with this tool constrains
lines to horizontal and vertical lines only. Holding down the CTRL
key while using this tool causes DeluxePaint to paint traces as you
draw. This means that DeluxePaint not only draws your final line but
also puts down in your painting all the intermediate lines that
appeared on the screen as you were dragging the mouse.

Command-clicking the icon brings up the Spacing Dialog Box (refer to
Figure 2.5). The Spacing Dialog Box lets you specify the space
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between the paint "splats" deposited by the brush to produce a dotted
line. Absolute spacing sets the number of pixels between each splat of
the brush. Relative spacing defines the total number of splats that
will occur along the line. You can define the number of splats by
clicking the Number box, deleting the existing value, and typing the
new value. Click On if you wish to have spacing on (an X appears in
the box). Click the On box again to turn spacing off. When Spacing is
on, it is also in effect for the Curve tool and the Unfilled Shape tools.

CURVE TOOL
(Keyboard Equivalent: q; Mnemonic: qurve)

Draws an arc. Draw a line between the beginning and ending points of
the arc as though you were using the Straight Line tool (see above)
and release the mouse button. Then drag the line until the arc is the
right shape, and click the button. Holding down the CfRL key while
using this tool causes DeluxePaint to paint traces as you draw.
Command-clicking the icon brings up the Spacing Dialog Box (see
above).

FILL TOOL
(Keyboard Equivalent: f; Shift F: Fill Type Dialog Box; Mnemonic:

fill)

Select the Fill tool by clicking the icon. The spout of the Fill tool is
the bottom of the dripping paint. The Fill tool fills an enclosed area
of any color with the current color or pattern. Command-clicking the
icon brings up the Fill Type Dialog Box (refer to Figure 3.1). You can
fill enclosed objects with the following: Solid, Perpective, Pattern, or
one of three types of Gradient fill. 1) Solid fills with the current color;
2) Perspective fills with the pattern made from your brush in the
Perspective mode (see Perspective under the Brush menu, above); 3)
Pattern fills with the pattern made from the current brush in standard
mode. (To create a pattern to use for Pattern fill, first select Get Brush.
This creates a pattern from your current brush and displays it to the
right of the Get Brush button.)

4) Gradient fills with a spread of colors from the cycle range of the
current foreground color. Click one of the three Gradient options with
the mouse button: Horizontal Fill (the top Gradient button) lays the
gradient horizontally from top to bottom. Vertical Fill (the middle
Gradient button) lays the gradient vertically from left to right with
an even distribution. Horizontal Line Fill (the bottom Gradient
button) lays the gradient left to right one line at a time, adjusting the
gradient on each line so that it follows the contours of the shape being
filled. You can specify the direction of the gradient fill (that is, the
colors in the cycle range DeluxePaint begins filling with) by clicking
the appropriate Cycle Direction Arrow in the Palette Window.
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Dither controls the degree of llUXlng of colors in the gradient fill.
Move the Dither scroll box by sliding it left or right with the mouse
button. Setting Dither all the way to the left gives you no overlap
between each shade. Moving the Dither scroll box to the right
increases the amount of "noise" between the color boundaries. When
you return to the painting screen, the current gradient (or pattern, if
Pattern or Perspective is selected) and its orientation are shown in the
Color Fill box (see Info Bar in the Edit menu, above).

AIRBRUSH TOOL

Sprays with the current brush. Command-clicking the icon brings up
the Size cursor (a box with a smaller box inside), which allows you to
define the nozzle size and hence the spray area. To resize the brush,
press the mouse button, drag, and release.

Note: The following Filled Shape tools all fill in accordance with
the current settings in the Fill Type Dialog Box. See discussion under
the Fill tool, above.

UNFILLEDIFILLED RECfANGLE TOOL
(Keyboard Equivalent: r - Unfilled; R - Filled; Mnemonic:

rectangle)

Click the upper left part of the icon to select Unfilled Rectangle and
the lower right to select Filled Rectangle. Draw a rectangle by
dragging diagonally on the page. The Unfilled Rectangle paints with
the current brush (whether it is a built-in or custom brush). Holding
down the Shift key while drawing with this tool constrains rectangles
to squares. Holding down the CfRL key while using the Unfilled
Rectangle causes DeluxePaint to paint traces as you draw. Command
clicking brings up the Fill Type Dialog Box (see above).

UNFILLEDIFILLED CIRCLE TOOL
(Keyboard Equivalent: c- Unfilled; C - Filled; Mnemonic: circle)

Click the upper left of the icon to select Unfilled Circle and the lower
right to select Filled Circle. Draw a circle by dragging diagonally on
the page. The Unfilled Circle paints with the current brush (whether
it is a built-in or custom brush). Holding down the CfRL key while
using the Unfilled Circle causes DeluxePaint to paint traces as you
draw. Command-clicking brings up the Fill Type Dialog Box (see
above).

UNFILLEDIFILLED ELliPSE TOOL
(Keyboard Equivalent: e - Unfilled; E- Filled; Mnemonic: ellipse)
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Click the upper left of the icon to select Unfilled Ellipse and the
lower right to select Filled Ellipse. Press and drag to draw the
ellipse; release. After you release, you can move the mouse to further
define the size and shape of the ellipse. Then press and drag again to
define the rotation of the ellipse. Release to draw the ellipse.
Holding down the CfRL key while using the Unfilled Ellipse causes
DeluxePaint to paint traces as you draw. Command-elicking the icon
brings up the Fill Type Dialog Box (see above).

UNFILLEDIFILLED POLYGON TOOL

Click the upper left of the icon to select Unfilled Polygon and the
lower right to select Filled Polygon. Click and drag to "tack" each
point of the polygon down. Clicking your polygon's point of origin
completes it. Or you can complete the polygon without having to
search for the point of origin by pressing the Spacebar. Holding down
the Shift key while drawing a side of the polygon constrains that side
to a horizontal or vertical line. Holding down the CfRL key while
using the Unfilled Polygon causes DeluxePaint to paint traces as you
draw. Command-elicking the Polygon tool brings up the Fill Type
Dialog Box (see above).

BRUSH SELECfOR
(Keyboard Equivalent b for new brush, B for previous brush;

Mnemonic: brush)

Allows you to 1) create a custom brush from any image (picture or text)
on the page and 2) recall your most recent custom brush.

1) To create a new brush, click the Brush Selector tool once. Then,
press the mouse button and drag diagonally on the page until the
image is surrounded by a selection box. When you release the button,
the image remains where it is and becomes your current brush. Any
colors in the brush that match the current background color will be
transparent. To lift an image off the background onto your brush, press
the Command key and the mouse button, drag until your section is
surrounded, and release the mouse button. When you lift an image, the
space left behind will fill with the current background color. To pick
up an image from a crowded area, click the Brush Selector twice (the
Brush Selector icon becomes a diamond). Then, by dragging and
clicking, draw a "corral" around your object, as if you were using the
Polygon tool (see above). You can also use the Command key with the
Corral feature.

2) To recall your most recent brush, Command-elick the Brush Selector
or press Shift-B.
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TEXT
(Keyboard Equivalent: t; Mnemonic: text)

To create text, click the text icon ("A") in the Toolbox or type t, the
keyboard equivalent. Change the current foreground color to the color
you want for your text. From the Font Menu, select the desired font
(such as Chicago 12 point) and style (Plain, Bold, or Underline). Click
the mouse button where you want the text to begin.

Type your text from the keyboard. The text will automatically wrap
around the right edge of the page and restart at the left margin, in
alignment with the initial cursor position. Pressing Return starts a
new line, in alignment with the original cursor position. Use the
Delete key to erase on the current line. If your page size is larger than
the screen, the page scrolls as you type off the edge of the screen.
Note, however, that you cannot delete typed characters (by using the
Delete key) once the screen scrolls. In that case, you would need to
delete the text as you would any other image, by painting over it with
the background color. Press ESC or click a drawing tool to exit Text
mode.

GRID
(Keyboard Equivalents: g - grid on/off; Shift-G - grid on, aligned

with brush location; Mnemonic: grid)

Grid constrains the action of the drawing tools. Command-clicking the
Grid icon brings up the Grid Dialog Box (refer to Figure 2.1). Use the
Grid Dialog Box to adjust the x and y Spacing of the grid. You can
specify the grid values in pixels by deleting the existing values and
typing in the new ones. Or you can click From Brush to set your grid to
the dimensions of your brush. Alternatively, you can click the Adjust
box, which lets you visually place and adjust the grid. Position the
grid and then press the mouse button and drag to adjust the size. If you
use Shift-G to turn the grid on while using a brush, the grid will use
the current brush position as one of its points.

If you bring up the Grid Dialog Box while you are in Perspective mode,
you will be able to specify the Spacing on all three axes x, y and z, in
the same manner. Alternatively, you can click From Brush to set the x
and y spacing to the current brush dimensions. (Z defaults to the same
value as y). In addition, you can change the increment of rotation
caused by the Shift key by specifying the new angle (between 2 and 89
degrees) in the Angle Step box. For example, if you set the Angle Step
value to 45 (instead of the default 90), DeIuxePaint rotates the brush
45 degrees about the x-axis every time you press the Shift key and
Keypad 8. Three-dimensional gridding and incremental rotation
make it easy to create solid figures, such as cubes and other
polyhedrons. See Tutorial 4, Cubism Revisited, for a simple exercise
using gridding.
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Figure 4.5. Perspective Grid Dialog Box

[Cancel ]OK¢

MAGNIFY
(Keyboard Equivalent: m; Mnemonic: magnify)

SYMMETRY
<Keyboard Equivalent: I)

Click the icon to select the tool. Position the Magnify box over the
part of the image you want to enlarge and click with the mouse button.
To change the magnification scale, click the Up or Down Arrow inside
the Zoom icon (to the right of the Magnify Tool): Clicking the Up
Arrow enlarges the image, clicking the Down Arrow shrinks it. In the
magnified and unmagnified areas, you can scroll around using the
arrow keys or the n key, which moves the area under the cursor to the
center of the magnified area. All other tools work in Magnify mode.
To turn off Magnify when the magnified area is displayed, click the
Magnify icon again, or press m.

Ang I e Step: r 90 I Degrees

Perspective Grid

X Spacing: 1~
Y Spacing: 1 6

Z Spacing: 1 6

[ From Brush ]

Symmetry works with all tools except Text and Brush Selector.
Command-clicking brings up the Symmetry Dialog Box (refer to Figure
2.2) where you can choose from two symmetry modes: Point and Tile.
Point Symmetry works around a central symmetry point in either
Mirror (mirror image duplication of each point) or Cyclic (duplication
at each symmetry point). In Point Symmetry, you can select the
number of symmetry points (up to 40) and the location of the symmetry
center. Use Tile Symmetry to create 'tile' patterns. You can set the
horizontal and vertical dimensions (in pixels) of the tile size. Tile is
useful in creating fill patterns. Always start with a blank page when
using Tile Symmetry. To cancel Symmetry, click the Symmetry tool
again.
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ZOOM
(Keyboard Equivalent: > enlarge; < shrink)

Changes the scale in Magnify mode (see Magnify tool, above). Oick
the top left half of the Zoom icon (the Up Arrow) to enlarge the
image, and click the bottom right half of the icon (the Down Arrow) to
shrink it.

UNDO
(Keyboard Equivalent: u; Mnemonic: undo)

Reverses the last draWing action provided there has not been an
intervening mouse click. For example, if you create a rectangle and
immediately select Undo, DeluxePaint erases the rectangle from the
screen. If you create the rectangle and then select another tool before
you select Undo, DeluxePaint does not erase the rectangle.

CLR
(Keyboard Equivalent: Shift-K or the Clear key on the keypad;
Mnemonic: Klear)

Clears the screen to the currently selected background color.

COLOR INDICATOR

Indicates the current foreground and background colors. Clicking the
Color Indicator with the mouse button or pressing the comma (,) from
the keyboard changes your cursor into four crosses, the Select Color
cursor. This lets you select a new foreground or background color by
clicking a color onscreen. Clicking the onscreen color with the Select
Color cursor selects a new foreground color, and Command-elicking
selects a new background color.

Command-elicking the Color Indicator brings up the Palette Window
(refer to Figure 2.4).

PALETTE (also called Main Palette)

Clicking a color in the Palette (below the Toolbox) selects a new
foreground color. Command-elicking selects a new background color.
The current foreground and background colors are displayed in the
Color Indicator.
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(For 1-8, use number keys on main part of keyboard, not keypad)

Il KEYBOARD COMMANDS AND CURSORS

BRUSH COMMANDS

Rotate about the x-axis
Rotate 90 degrees about the x-axis
(default)
Reset x-axis to zero
Fix x-axis

Rotate about the y-axis
Rotate 90 degrees about the y-axis
(default)
Reset y-axis to zero
Fix y-axis

Keypad 6
Shift Keypad 6

Y-Axis Commands:
Keypad 4 and 5
Shift Keypad 4 and 5

X-Axis Commands:
Keypad 7 and 8
Shift Keypad 7 and 8

Keypad 9
Shift Keypad 9

1 Matte mode
2 Color mode
3 Replace mode
4 Smear mode
5 Shade mode
6 Blend mode
7 Cycle mode
8 Smooth mode

Reduce brush size
Shift - Reduce brush size twice as much as-

::: Increase brush size
Shift::: Increase brush size twice as much as :::

Z Stretch
h Halve
H Double
x Flip horizontal
X Double horizontal
y Flip vertical
Y Double vertical
z 90 degree rotate

PERSPECTIVE COMMANDS

",-,=-----k-------=='"'---_4._32 ~
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Rotate about the z-axis
Rotate 90 degrees about the z-axis
(default)
Reset z-axis to zero
Fix z-axis

Enter Perspective mode
Reset perspective center
Reset all axes to zero
Reset all axes to zero and
perspective center to default state
Fill the screen with the current
brush at the current perspective
Move the brush along the fixed
axis in a direction perpendicular to
the brush plane
Same as ; and I keys but with a
greater increment
Modify observer distance from
screen

< and> (Shift. and Shift ,)

Keypad - (Minus)

Keypad 3
Shift Keypad 3

: and" (Shift; and ')

; and I

Z-Axis Commands:
Keypad 1 and 2
Shift Keypad 1 and 2

Other Commands:
Enter
Keypad. (Decimal Point)
Keypad 0
Shift Keypad 0

Note: If your keyboard does not have a keypad, see your Reference
Card.

b Brush Selector tool; if clicked again, Corral tool
B Restore last custom brush
c Unfilled Circle tool
C Filled Circle tool
d Continuous Freehand tool
D Continuous Freehand tool with I-pixel brush
e Unfilled Ellipse tool
E Filled Ellipse tool
f Fill tool
F Fill Type Dialog Box
g Grid
G Grid to current brush position
j Spare page
K Clear page
m Toggle Magnify tool

TOOLBOX COMMANDS
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Shift

4.34

Toggle Info Bar
Toggle Menu Bar and Toolbox/Palette
Toggle cursor
Scroll page; in Text mode, move cursor
Center area under the cursor; In
Magnify mode, move area under the
cursor to center of magnified area
Constrain with Rectangle, Straight
Line, and Polygon tools
Leave traces with Line or Shape tools
Check memory
Toggle color cycle
Show page

Display Color Settings Dialog Box
Undo last color change
Select Range 1, 2, 3, or 4
Move Color Selector up and down
Move top end of Range bracket up
and down
Move bottom end of Range bracket
up and down

Palette Window
Curve tool
Unfilled Rectangle tool
Filled Rectangle tool
Dotted Freehand tool
Text
Undo
Straight Line tool
Zoom in (to enlarge magnified image)
Zoom out (to shrink magnified image)
Select Color cursor
Move Color Selector up and down the palette
One-pixel brush
Toggle Symmetry

CfRL
CfRLa
Tab
S

9
o
ESC
<- and->
n

~ and v

/

s
t
u
v
>
<

n
u
1,2,3, or 4
[ and]
<- and->

p
q
r
R

,
[ and]

SPECIAL KEYS

PALETIE WINDOW COMMANDS
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alphabet.)

(to left of
Spacebar)

a
Spacebar

CURSORS

~ Standard

I
Crosshatch-i-

I Text

~ Watch

() Fill Bucket

..:~ Select Color

E!l Size

mGrid

83 Perspective Brush
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Toggle stencil

Repeat last menu option (Again key)
Abort current command

Select items in Toolbox, Palette,
and Dialog Boxes; draw with a
custom brush
Draw with a built-in brush

Enter text

Tell user to wait for completion
of computer activity
Fill closed object with a solid,
pattern, perspective, or gradient
fill
Change current background or
foreground color by clicking an
onscreen color; Select another color
after using Copy, Swap, or Spread in
the Palette Window
Change size of a built-in brush
or the Airbrush
Adjust size and alignment of
current grid

Move a custom brush in
Perspective mode
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A
Airbrush tool, 1.8,4.27

modifying, 2.17
Animation with color cycling, 3.10-3.11
Anti-aliasing, 3.29, 4.19-4.20
Apple (tl) menu, 4.2

About DeluxePaint, 4.2
Desk Accessories, 4.2

B
Back->Fore Brush, 3.14, 4.23
Back<->Fore Brush, 3.14, 4.23
Back->Fore Pict, 4.22
Back<->Fore Piet, 4.22-4.23
Background

color, 1.3-1.4
fixing, 1.15-1.16,2.12,3.23-3.24,4.11
restoring, 1.15-1.16, 4.11

Bend Horizontal command, 4.15-4.16
Bend Vertical command, 3.13, 4.16
Blend command, 2.20-2.21, 4.13
Brush Handle, 2.4-2.5, 4.7
Brush menu, 2.4, 4.15-4.20. See also Brushes

Bend Horizontal, 4.15-4.16
Bend Vertical, 3.13, 4.16
Double, 4.15
Flip Horizontal, 4.15
Flip Vertical, 4.15
Halve, 4.15
Options, 4.19-4.20
Perspective, 4.16-4.19
Rotate, 4.15
Shear, 3.12, 4.16
Stretch, 3.13, 4.15

Brush Selector, 1.11-1.12,2.2,2.3,4.28
effect on Background color, 2.3
modifying, 2.20-2.21
repositioning text with, 2.21-2.22

Brushes. See also Brush menu
bending, 3.13
built-in, 1.6, 2.17, 4.25
changing colors of, 1.4,2.4,3.14
creating custom, 2.2-2.4
filling with pattern, 3.15
handle, 2.4-2.5, 4.7
keyboard command summary, 4.32
loading, 2.4, 4.3
modifying, 2.17
palette, 4.23

resizing, 3.13, 4.16, 4.25
rotating, 325-3.36
saving, 4.3
selecting complex shapes for, 2.3
slanting, 3.12
symmetrical,2.9-2.10
transparent background of, 2.3

c
Choose Screen Format dialog box, 2.13, 4.9
Circle tool, 1.10,4.27
CLR button, 1.4, 1.15-1.16,2.12,4.31
Color command, 3.16, 4.12
Color cycling, 2.16, 3.10-3.11

speed of, 3.11, 4.22
Color Fill Box, 4.6
Color Indicator, 1.4, 3.2, 3.14, 4.31
Color menu, 4.20-4.24

Back->Fore Brush, 3.14,4.23
Back<->Fore Brush, 3.14, 4.23
Back->Fore Pict, 4.22
Back<->Fore Piet, 4.22-4.23
Cycle, 3.11, 4.22
Default Palette, 1.15, 4.22
Palette, 4.20-4.22
Remap Brush, 4.24
Remap Pict, 4.23
Restore Palette, 4.22
Use Brush Palette, 4.23

Colors
background, 1.3
brush,1.4
foreground, 1.4
number available, 2.13
page, 1.3
creating, 2.14-2.16, 3.2-3.10

Color Settings dialog box, 4.21
Command key, 1.4, 1.5,2.2,2.3,2.17-2.20
Constraining lines and shapes, 1.9
Continuous Freehand tool, 1.7,4.25
Control key (CTRL), 1.10
Coordinates command, 4.5
Copy command, 4.5
Copy to Spare command, 4.11
Crosshair pointer, 1.5,4.34
Cubes, creating, 3.30-3.32
Cursors, 4.35
Curve tool, 1.7-1.8,4.26

modifying, 2.17-2.18
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Cut command. 4.5
Cycle command (Color menu), 3.11, 4.22
Cycle command (Mode menu), 4.14

D
Default Palette command, 1.15, 4.22
Default color settings, 1.3
Delete this Page command. 4.12
Desk Accessories, 4.2
Disks, copying, 1.1-1.2
Dither, 2.19-220, 427
Dotted Freehand tool, 1.7,4.25
Dotted lines, 2.17-2.18
Double command, 4.15
Double Horizontal command, 4.16
Double Vertical command, 4.16
Drop shadows, 3.16

E
Edit menu, 4.4-4.8

Brush Handle, 2.4-2.5, 4.7
Copy, 4.5
Coordinates, 4.5
Cut,4.5
Excl Brush, 2.8, 4.7
Fast Feedback, 2.5, 4.5
Info Bar, 2.6, 4.6
Paste, 4.5
Square Aspect, 4.8
Undo, 4.4

Ellipse tool, 1.10,4.27-4.28
Excl brush, 2.8, 4.7

F
Fast Feedback command, 2.5, 4.5
File menu, 4.2-4.4

Load Brush, 4.3
Load Picture, 4.2
Load Stencil, 4.3
Choose Printer, 4.4
Print, 4.4
Quit, 4.4
Save Brush, 4.3
Save Picture, 4.2
Save Stencil, 4.3

Files
loading, 1.14-1.1
naming, 1.13
saving, 1.12-1.14

Fill tool, 1.8,3.15,4.26-4.27
modifying, 2.18-2.20

Fill Type dialog box, 2.18

Fix Background, 1.15-1.16,2.12,3.23-3.24,
4.11
Flip Horizontal command, 4.15
Flip Vertical command, 4.15
Folders, 1.13

creating, 4.3
naming, 4.3
opening, 1.15

Font menu, 2.22, 4.24
Point Sizes (8, 10, 12, 14),4.24

Foreground color, 1.4
Free Background. 1.16,4.12
Free Stencil command, 3.23-3.24, 4.12
Friskets,3.19-3.24

G
Gradient Fill, 2.16, 2.19-2.20, 3.8,3.17-3.18,
4.26-4.27
Grid dialog box, 2.8
Grid tool, 2.7-2.9, 3.30-3.32,4.29-4.30

modifying grid, 2.20

H
Halve, 4.15
Handle, brush, 2.4-2.5,4.14
Hardware, 1.1
High Resolution format, 2.13, 4.9
HSV color mixing, 2.15

I
Info Bar, 2.6, 4.6

K
Keyboard commands

brushes, 4.32
Palette Window, 4.34
perspective, 4.32-4.33
special, 4.34
tools, 4.25-4.31, 4.33

Keydisk system, 1.2

L
Load Brush command, 4.3
Load Picture command, 1.14-1.15, 4.2
Load Picture dialog box, 1.14
Load Stencil command, 4.3
Lock Foreground, 3.24, 4.10
Logo tutorial, 3.12-3.18
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M
Magnify tool, 2.6, 4.30
Make Stencil oommand, 3.20-3.24, 4.9-4.10
Make Stencil dialog box, 3.20
Matte oommand,3.16-3.17,4.12
Medium Resolution format, 2.13, 4.9
Memory availability display, 4.6, 4.34
Menu Bar, 1.12, 4.1

hiding, 2.6
Mixing palette, 2.14-2.16
Mode menu, 2.21,4.12-4.14

Blend, 2.20-2.21,4.13
Color, 3.16, 3.17, 4.12
Cyde,4.14
Matte, 3.16, 3.17, 4.12
Multi-Cycle,4.14
Replace, 4.12
Shade, 2.20-2.21,4.13
Smear, 2.20-2.21, 4.12
Smooth, 2.20-2.21, 4.14

Mouse button, 1.4, 1.6,4.25-4.31
with Command key, 1.4, 1.5-1.16, 2.3,
2.17-2.20,4.25-431

Multi-Cycle command, 4.14

o
Options oommand,3.29, 4.19
Outline of a shape, creating, 3.17

p
Page Size command, 2.12, 4.8-4.9
Pages, 13,2.11-2.12

color, 13
copy to spare page, 4.11
delete current page, 4.12
reduced view, 4.9
size, 2.12, 4.8-4.9
switching, 2.11,4.11

Paint can. Sa Fill tool
Painting area, 13
Painting modes, 2.20-2.21,4.6, 4.12-4.14
Painting Screen, 1.3
Palette, 13-1.4,2.13-2.16,3.2,4.20-4.22,4.31

creating, 3.2-3.10
default, 1.15
restoring, 1.15

Palette command, 4.20-4.22
Palette Window, 2.13-2.16, 3.2, 4.20-4.22

copying colors, 2.16, 3.3, 4.21
exchanging colors, 2.16, 4.21

Gradient Fill, 2.16, 3.8-3.10, 4.26-4.27
modifying Palette, 3.2-3.10
range for gradient fill, 3.8-3.10, 3.17-3.18
ranges and spreads, 3.6-3.10, 4.21

Paste oommand, 4.5
Pattern fill, 3.15, 4.26
Perspective, 2.5, 3.25-336,4.16-4.20

anti-aliasing, 3.29, 4.19-4.20
axes, 3.25
brush, 2.5
command, 4.16-4.20
fill, 4.19,4.26
fixing axes, 333-336, 4.17-4.18
keyboard oommand summary, 432-433
rotating brush on axis, 3.26-336,
4.17-4.18
rotation, absolute and relative, 4.19
rotation value of Shift key, 3.28,
4.29-4.30
setting perspective center, 3.27, 4.17

Perspective Grid dialog box, 430
Perspective Options dialog box, 4.19
Pid menu, 4.8-4.12

Copy to Spare, 4.11
Delete this Page, 4.12
Fix Background, 4.11
Free Background, 4.11
Free Stencil. 4.11
Lock Foreground, 4.10
Make Stencil. 4.9-4.10
Page Size, 4.8-4.9
Reverse Stencil, 4.10
Screen Format, 4.9
Show Page, 4.9
Spare Page 2.11,4.11
Toggle Stencil, 4.10

Pixel, 1.6
Polygon tool. 1.10-1.11,4.28
Power up, 1.2-13
Print command, 4.4

Q
Quit command, 4.4

R
Rectangle tool, 1.9, 4.27
Remap Brush command, 2.4, 4.24
Remap Picture command, 4.23
Replace command, 4.12
Resolutions, screen, 2.13, 4.9
Restore Palette command, 1.15,4.22
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Reverse Stencil command, 4.10
RGB color mixing, 2.14-2.15
Rotate command, 4.15

5
Save Brush command, 1.12,4.3
Save Picture command, 1.12-1.14,4.2-4.3
Save Picture dialog box, 1.13
Save Stencil command, 4.3
Screen Format command, 2.13, 4.9
Screen resolutions, 2.13, 4.9
Scroll box, 1.13
Set Page Size dialog box, 4.8
Shade command, 2.21, 4.13
Shape tools, modifying, 2.18-2.20
Shear command, 3.12, 4.16
Shift key, 1.9,3.28,4.28-4.29
Show Page command, 2.12, 4.11
Single-drive operation, 1.2
Slanting image, 3.12
Smear command, 2.20-2.21, 4.12
Smooth command, 2.20-2.21,4.14
Spacebar, 1.8, 2.3,4.34
Spacing dialog box, 2.18
Spare Page command, 2.11, 4.11
Spread, color, 3.6-3.8, 4.21
Square Aspect, 1.9, 4.8
Stencils, 3.19-3.24, 4.9-4.11
Straight Line tool, 1.7, 4.25-4.26

modifying, 2.17-2.18
Stretch command, 3.13, 4.15
Symmetry dialog box, 2.9
Symmetry tool, 2.9-2.10, 4.30

modifying, 2.20

T
Text, 2.21-2.22, 4.29
Toggle Stencil, 4.10
Toolbox, 1.4, 1.5, 1.7-1.12,4.25-4.31. See also
individual tool names

hiding, 2.6
keyboard commands, 4.25-4.31, 4.32-4.34
modifying tools, 2.17-2.20

Traces, 1.10

U
Undo button, 1.4, 1.15,4.31
Undo command (in Edit menu), 4.4
Use Brush Palette command, 2.4, 3.12, 3.26,
4.23

V
Version number information, 4.2

Z
Zoom, 2.7,4.31
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